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VCM Suite is a comprehensive tuning tool that allows performance tuning and 
diagnostics, whether you want to improve the fuel economy of your daily driver or 
maximize your performance on the race track. 

The suite has two components:

￭ VCM Editor allows users to adjust many of the parameters that control the 
operation of the engine and transmission.

￭ VCM Scanner allows users to monitor, log, and review key data that provides 
insight into the effectiveness of the vehicle's current tune. With such insight, a 
skil led tuner can return to VCM Editor and further refine the tune.

This guide covers the use of VCM Scanner.

WHAT'S NEW IN VCM SCANNER?
Recent changes to VCM Scanner are listed below, For a historical l ist of changes, see 

the VCM Scanner Changelog .

VCM SCANNER 5.0

GENERAL

￭ MPVI3 and RTD gen 3 . VCM Scanner now supports our latest generation of 
interface devices.

￭ Multi-language support. It 's a work in progress, but we have begun to translate 
portions of the VCM Suite user interface. See Selecting the Displayed Language 
(Page 22) for more information.

￭ Improved Vehicle Profile Editor. You can now load and save vehicle profiles and 
import them from log files. Doing channel configuration for vehicles that are 
located remotely just got a whole lot easier. See Vehicle Profiles (Page 37) for more 
information.
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SCANNING

￭ Markers are back! While scanning, you can place a marker in the log by pressing the 

M key. During playback, the marker will be displayed in the timeline. See Scanning 
Procedure (Page 35).

LAYOUTS

￭ Drive Cycle panel. You can now add a Drive Cycle panel to your layouts to help with 
emissions and fuel economy testing. See Drive Cycle Panel (Page 149).

￭ Histograms. New type of graph in the Graph panel. See Graph Panel Histograms 
(Page 122).

VEHICLE SUPPORT

Added support for:

￭ 2007-2018 Audi TT 2.0 TFSI

￭ 2007-2020 Audi TTS 2.0 TFSI 
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GETTING STARTED WITH VCM SCANNER
1. It is recommended you have the following before you begin using VCM Scanner:

￭ An account on hptuners.com.

￭ An interface device from HP Tuners that has been registered.

NOTE: For detailed explanations of all of these topics (and more), see the 
VCM Suite Getting Started Guide.

2. When you are ready to begin, connect to the vehicle:

a. Connect your laptop to the vehicle. See Connecting to a Vehicle (Page 23).

NOTE: Certain vehicles may require special cables to connect to the 
vehicle. 

b. If VCM Editor is open, close it now.

c. Open VCM Scanner.

d. Turn the vehicle ignition to a position other than OFF. (The engine can be 
running or stopped. But, the vehicle must supply power to the OBD-II port.)

e. Click the  icon in the toolbar to open a data connection to the vehicle.

3. ALWAYS check the vehicle for diagnostic trouble codes (DTCs)  and resolve any 
issues reported before you do anything else. If there is a mechanical issue with the 
vehicle, it may affect performance and any performance data you want to monitor 
could be impacted. This makes it very difficult to tune the vehicle effectively. 

a. Click  . The Diagnostics & Information window appears.

b. Click Read DTCs . VCM Scanner will query the vehicle for diagnostic 
information. 

See Reading and Clearing DTCs (Page 29) for more information.
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4. While connected to the vehicle, you can do a quick initial scan of its performance 
an emissions behavior using VCM Scanner's default settings. Follow these steps:

a. Click  to start a live scan.

b. To stop scanning, click .

c. If you want to save this scan data to a log file, click .

See Live Scanning and Logging (Page 33) for detailed instructions.

5. Once you have a basic familiarity with the scanner interface, it is l ikely that you will 
want to start customizing it for the job at hand. VCM Scanner is capable of 
retrieving, displaying, and logging a broad range of data from a variety of sources. 
Creating the best setup for a particular troubleshooting or tuning task typically 
includes the following steps:

a. Add channels to retrieve the data you want to view and/or log. Most channels 
are data received through the vehicle's OBD-II diagnostics port. But, you can 
also add data received from an external device connected to your HP Tuners 
interface or  to your computer's serial port. See Channels (Page 65) for instruc-
tions.

b. Modify the displayed layouts (gauges, graphs, and charts) to include the 
parameters you need to see. Refer to Layouts (Page 99) for more information.
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Item Description

1. Menu Bar. See Menu Bar (Page 16) for descriptions of individual 
menus.

2. Toolbar. See Main Toolbar (Page 20) for descriptions of 
individual items.
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Item Description

3.

Data Display Panels. When actively scanning a connected 
vehicle, the panels in this area display live data gathered from 
the vehicle. When viewing a log file, they display the logged 
data. All of these displays are highly configurable. They can be 
set up to show the performance and troubleshooting data 
most appropriate for the task at hand. See Layouts (Page 99) 
for more information.

4.

Timeline. When playing back a log file, the slider on this 
timeline indicates the moment you are currently viewing. Slide 
right or left to jump forward or back in the recorded log data. 
See The Timeline (Page 61).

5.
Details Tab. Click this tab to view the Details panel. When a log 
file is open, this panel displays information about the file and 
the logged vehicle. See The Details Panel (Page 63).

6.
Channels Tab. Click this tab to view the Channels display, 
which is used to view and configure channels. See Using the 
Channels List (Page 66).

Page 15



VCM SCANNER USER GUIDE

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

MENU BAR

VCM Scanner's menu bar includes the following menus:

LOG FILE MENU

The Log File menu allows you to open, close, and save files containing the log data you 
have recorded.

￭ Open Log File. Open a saved log file.

￭ Close Log File. Close the currently-open log file.

￭ Save Log File As. Save the data that VCM Scanner has recorded to a log file.

NOTE: Due to changes in file content, log files saved in VCM Suite version 4.13 
(and later) cannot be opened in versions older than 4.13.

￭ Export Log File. Export recorded log data to a format that can be imported easily 
into many spreadsheets and data processing applications (.csv file).

￭ Recent Logs. Select a file to open from a list of log files you have accessed 
recently.

￭ Exit. Exit VCM Scanner.

VEHICLE MENU
￭ Connect. Connects the interface device to the vehicle.

￭ Disconnect. Disconnects the interface device from the vehicle.

￭ Vehicle Profiles. Selecting a profile from this list loads the channel l ist in the 
selected profile.

￭ Repoll for Supported Parameters. Poll the connected vehicle to determine what 
channels are available for logging. Regular usage of this feature is recommended. 
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This helps ensure that the list of available channels is correct.

￭ Start Scanning. Begin recording data from the vehicle.

￭ Stop Scanning. Stop recording vehicle data.

￭ Diagnostics & Info. Opens the Diagnostics & Information window, which is used to 
read DTC codes and to check to see if all emissions readiness tests have been 
completed. The window also contains some fault analysis tools. See Diagnostics & 
Information (Page 27).

￭ Controls & Special Functions. Open the Controls & Special Functions window, 
which allows you to instruct the vehicle to perform certain tasks in real time. See 
Controls and Special Functions (Page 185).

￭ MPVI Pro Data Logging. Opens the MPVI Pro Standalone Data Logging window. If 
you are using an MPVI Pro, this window can be used to initiate Standalone Data 
Logging for certain late model GM vehicles. See MPVI Pro Standalone Data Logging 
(Page 46) for more information.

￭ MPVI2 Data Logging. Opens the MPVI2 Standalone Data Logging window. If you are 

using an MPVI2/2+ with the Pro Feature Set or an MPVI3 , this window can be used to 
initiate Standalone Data Logging. See MPVI2, 2+, and 3 Standalone Data Logging 
(Page 50) for more information.

LAYOUT MENU

The options in this menu allow you to load and save custom screen layouts. See 
Layouts (Page 99) for more information.

￭ Open Layout. Open a layout that you have saved previously.

￭ Save Layout As. Save the current layout to a file.

￭ Recent Layouts. Displays a list of layouts that you have used recently. Select a 
layout from the list to load it.

￭ Default Layouts. Displays several pre-defined layouts, which can be used as is or 
serve as the basis for designing your own. Select a layout from the list to load it.

￭ Add To Layout. Select this item to add a new graph or chart to the current layout.

￭ Lock Layout. Select this option to lock the current layout so that it can no longer 
be modified.
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TOOLS MENU
￭ Unit Conversion. Opens the Unit Conversion window, which can quickly perform 

many common unit conversions. See Unit Conversion Window (Page 1).

￭ Math Parameters. See Math Parameters (Page 157).

￭ Quantities & Units . Opens the Quantities and Units window, which lists the types 
of units VCM Suite supports for various measured quantities. This can be useful 
when defining Math Parameters and Filters and when using the User Defined 
Parameters feature in VCM Editor. See Quantities & Units (Page 165).

￭ Calculator. Opens a window containing a simple calculator.

￭ Options. Opens the Options window, which contains user preference settings for 
the VCM Scanner application. 

HELP MENU
￭ Help. Opens VCM Scanner's help system.

￭ Resync Interface. When your computer is connected to the Internet and your 
interface device is connected to the computer, selecting this option will update 
the device to ensure that credits and licenses purchased since the last resync are 
properly stored on the device and will be available when you need them. Addi-
tionally, this function checks for updates to the device's firmware and applies any 
updates found.

NOTE: This is an important step in preparing a new interface for first time use. 

￭ VCM Suite Information. Opens the VCM Suite Info window. When your interface 
device is connected to the computer, this window can be used to generate a log 
file that contains troubleshooting information. See How to Generate a VCM Suite 
Infolog (Page 200).
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￭ MPVI Application Keys. Registration of older (MPVI) interface devices required 
entering an application key that was received by email. Selecting this menu option 
opens the window that allows application keys to be entered.

NOTE: Newer devices (MPVI2/2+/3) do not use application keys. They use veri-
fication codes for online registration.

￭ MPVI2 Verification Code. When a new MPVI2 or MPVI2+ is attached to a computer 
with an Internet connection, this option will produce a verification code that is 
used for device registration. 

￭ About. Displays a window that shows what version of the VCM Suite you are using. 
If there is an update to the software available, the window will have a Download 
button that you can use to retrieve the new version.
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MAIN TOOLBAR

VCM Scanner's main toolbar contains the following items:

Open an existing log file. 

NOTE: If you already have a file open, this will also close the currently 
open file.

Save the current scan to a log file.

NOTE: Due to changes in file content, log files saved in VCM Suite 
version 4.13 (and later) cannot be opened in versions older than 4.13.

Close the open log file.

Opens a data connection to the vehicle.

Closes the data connection to the vehicle.

Start Scanning

Stop Scanning

Opens the Diagnostics & Information window, which is used to read DTC 
codes and to check to see if all emissions readiness tests have been 
completed. The window also contains some fault analysis tools. See 
Diagnostics & Information (Page 27).

Opens the Controls & Special Functions window, which allows you to 
instruct the vehicle to perform certain tasks in real time. See Controls and 
Special Functions (Page 185).
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Opens the Real Time Tuning window.  See Real Time Tuning (RTT™) (Page 
171) for more information.

NOTE: This icon appears only if you are connected to a vehicle to which 
a custom operating system that supports RTT has been applied.

Begin playback of the log file you currently have open. The dropdown menu 
to the right of this button can be used to adjust playback speed.

When viewing log file data or actively scanning a vehicle, click this icon to 
zoom in on the timeline (show a shorter period of time in more detail). See 
The Timeline (Page 61) for more information on using the timeline.

When viewing log file data or actively scanning a vehicle, click this icon to 
zoom in on the timeline (show a longer period of time in less detail).

Opens a saved layout of gauges, graphs and/or charts. See Layouts (Page 
99) for more information.

Saves the current configuration of displayed gauges, graphs, and charts to a 
file. See Layouts (Page 99) for more information.

Opens the VCM Suite Info window. When your interface device is connected 
to the computer, this window can be used to generate a log file that 
contains troubleshooting information. See How to Generate a VCM Suite 
Infolog (Page 200).
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SELECTING THE DISPLAYED LANGUAGE

NOTE: This feature requires VCM Suite version 4.13 (or later).

In the most recent builds of VCM Suite, we have begun to implement support for 
changing the displayed language of the suite's applications. Follow these steps:

1. In the menu bar of either VCM Suite application, select Tools > Options . The 
Settings window appears.

2. In the Language dropdown, select the desired display language.

3. Click OK .

4. Close the application. The selected language should be displayed the next time 
either VCM Suite application is opened.

NOTE: At the time of this writing, only a portion of the interface supports alternate 
languages and some of the translated text is still rough placeholder text rather 
than a polished translation. Please bear with us while we work on expanding this 
feature's implementation.
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The procedure for connecting to a vehicle varies by the type of interface device you 
are using.

MPVI2/2+/3 AND ALL RTD INTERFACES
When used with the VCM Suite, a USB connection to your PC is recommended:

1. Connect the larger end of the included USB cable to an available USB port on a 
laptop with VCM Suite Installed. 

2. Connect the other end of the USB cable to the USB type C port on the front of the 
interface device.

 

3. When you are ready to scan or reprogram the vehicle, plug the large, molded 
OBD-II connector on the other side of the interface device into the vehicle's 
diagnostic port.

When used with the TDN app for mobile devices, these devices connect to your 
mobile via Bluetooth® . The app provides on-screen instructions for establishing the 
connection and attaching the device to your vehicle. For more information, consult 
the documentation for the TDN app.

Page 24



CONNECTING TO A VEHICLE

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

MPVI
1. Connect the larger end of the included USB cable to an available USB port on a 

laptop with VCM Suite Installed. 

2. Connect the other end of the USB cable to the USB type B port on the interface 
device.

3. Connect the 15-pin side of the OBD-II interface cable to the matching connector 
on the interface device.

4. When you are ready to scan or reprogram the vehicle, connect the 16-pin side of 
the OBD-II interface cable to the vehicle's diagnostic port.
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The Diagnostics & Information window displays the emissions monitor readiness 
status for the connected vehicle and can be used to view and clear Diagnostic Trouble 
Codes (DTCs).

To open this window, do one of the following (while connected to the vehicle):

￭ In the toolbar, click .

￭ in the menu bar, select Vehicle > Diagnostics & Info .

NOTE: On some older vehicles that use the ISO or SCI protocols, you cannot check 
DTCs while you are scanning.
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READING AND CLEARING DTCS
When you begin tuning a new vehicle, ALWAYS check the vehicle for diagnostic trouble 
codes (DTCs)  and resolve as many as you can before you do anything else. If there is a 
mechanical issue with the vehicle, it may affect performance and any performance 
data you want to monitor could be impacted. This makes it very difficult to tune the 
vehicle effectively.

IMPORTANT: Reading a vehicle's current tune will clear all DTCs, resulting in the 
loss of the troubleshooting information they contain. DO NOT read the tune until 
you have checked for DTCs here and resolved or made note of any issues 
reported. 

Follow these steps:

1. Physically connect your laptop to the vehicle. See Connecting to a Vehicle (Page 
23).

2. If VCM Editor is open, close it now.

3. Open VCM Scanner.

4. Turn the vehicle ignition to a position other than OFF. (The engine can be running 
or stopped. But, the vehicle must supply power to the OBD-II port.)

5. Click the  icon in the toolbar to open a data connection to the vehicle.

6. Click  . The Diagnostics & Information window appears.

7. Click Read DTCs . VCM Scanner will query the vehicle for diagnostic information. 
When finished, any DTCs detected will appear in the top half of the window.

8. Some vehicles report additional "freeze frame" data for individual DTCs. If this data 
is available for your vehicle, it can be viewed on the Freeze Frame tab.

9. Use the provided information to resolve as many issues as possible before tuning 
the vehicle.
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10. If desired, you can click Clear DTCs to tell the vehicle that the issue has been 
repaired.

NOTE: Clearing DTCs resets the emissions monitors. This will cause the 
vehicle to fail emissions testing until it completes the tests performed by the 
emissions monitors. These tests typically take several drive cycles to 
complete.

NOTE: If an issue has not been successfully repaired, a cleared DTC will be 
reported again.
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VIEWING FREEZE FRAME DATA
Some vehicles can report freeze frame data captured at the moment a DTC is set. This 
may be useful if you are trying to troubleshoot a DTC on a vehicle that supports this 
function. 

To see the freeze frame data for reported DTCs:

1. While connected to the vehicle, navigate to the Diagnostics & Information window.

2. Select the Freeze Frames tab.

3. Click Read Freeze Frames .
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CHECKING EMISSIONS MONITOR STATUS
In many countries, a vehicle's on board diagnostics must complete government-
specified self testing before they are allowed to report that the vehicle's emissions 
controls are functioning within legal l imits. 

Vehicles will not pass emissions testing until the required self tests are competed. 
Moreover, these "emissions monitors" reset whenever you clear DTCs, when the 
battery is replaced, and after some types of major maintenance. So, the vehicle will 
need to complete the self tests again after any of these events.

Follow these steps to verify that the emissions monitor tests have been completed:

1. Physically connect your laptop to the vehicle. See Connecting to a Vehicle (Page 1).

2. If VCM Editor is open, close it now.

3. Open VCM Scanner.

4. Start the engine.

5. Click the  icon in the toolbar to open a data connection to the vehicle.

6. Click  . The Diagnostics & Information window appears.

7. Click Read DTCs . VCM Scanner will query the vehicle for diagnostic information. 
When finished, the status of the emissions monitors will appear in the lower half 
of the window.

The three tests in the left column are run continuously and should indicate 
completion shortly after the engine is started. The tests in the right column may 
take several drive cycles to complete.

NOTE: If you are using VCM Suite version 4.13 or later, you can use the Drive 
Cycle Panel to help ensure that the tests in the right column are completed as 
quickly as possible.
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When paired with your HP Tuners interface device, VCM Scanner is capable of reading 
live data off the vehicle and displaying it on various gauges, charts, and graphs in real 
time.

When you are finished scanning, you can save your scan data to a log file for later 
review and analysis.

SCANNING CONFIGURATION
Although you can do a quick scan with the default settings, you can tailor the 
information retrieved from the vehicle to suit the task at hand. A little configuration 
can give you much better troubleshooting information and can make the presentation 
of that information much more suited to your personal working style.

Follow these steps:

1. When preparing to scan a new vehicle, connect to the vehicle briefly before you 
begin configuration. This will allow VCM Scanner to create a profile for the vehicle 
and attempt to load vehicle-specific parameters. See Creating a Vehicle Profile 
(Page 38) for instructions.

2. Add channels to retrieve the data you want to view and/or log. Although there are 
a few standard channels set up by default, you will need to add a channel for any 
additional parameter that you wish to monitor and any external device connected 
to your HP Tuners interface or to your computer's serial port. See Channels (Page 
65) for instructions.

3. Modify the displayed layouts (gauges, graphs, and charts) to include the 
parameters you need to see. Refer to Layouts (Page 99) for more information.
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SCANNING PROCEDURE
To do a live scan of the vehicle with the current configuration:

1. Connect your HP Tuners interface device to your laptop and then connect the 
interface to the OBD-II port on your vehicle. See Connecting to a Vehicle (Page 23) 
for details.

2. If VCM Editor is open, close it now.

3. Open VCM Scanner.

4. Turn the vehicle ignition to a position other than OFF. (The engine can be running 
or stopped. But, the vehicle must supply power to the OBD-II port.)

5. Click the  icon in the toolbar to open a data connection to the vehicle.

6. When VCM Scanner has finished connecting, click  to start scanning.

7. (VCM Suite version 4.13 or later) While scanning, you can insert a marker at the 
current time index:

￭ Press M on your keyboard to insert a marker without a comment.

￭ Press C to insert a marker and add a comment.

When playing back a log file, markers appear as green bars in the timeline. Longer 
key presses will generate wider bars. See The Timeline (Page 61).

NOTE: Although comments are saved in the log file, version 4.13 can't display 
them yet. Look for this feature to be added in a future release.

8. To stop scanning, click .

9. If you want to save this scan data to a log file, click .
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GENERATING A LOG FILE
Scanned data can be saved to a log file, which can be opened later for further review 
and analysis. There are two ways to generate such a file:

￭ Save a live scan.

￭ Configure your interface device for standalone data logging.

SAVING A LIVE SCAN

NOTE: Due to changes in file content, log files saved in VCM Suite version 4.13 (and 
later) cannot be opened in versions older than 4.13.

Follow these steps to generate a log file from a live scan:

1. Ensure that your channel setup includes all the parameters you want to capture in 
the log. See Channels (Page 65).

2. Connect to the vehicle and perform a live scan. See Scanning Procedure (Page 35)

3. When the scan is complete. Click  in the toolbar.

4. Enter an appropriate file name and click Save .

STANDALONE DATA LOGGING

Standalone data logging allows you to save a log file to the memory of your HP Tuners 
interface device when the device is not connected to your computer. For the full 
procedures associated with generating such a log file, see Standalone Data Logging 
(Page 45). 

In short, however, the steps are as follows:

1. Connect your interface device to your computer.

2. In VCM Scanner, configure your interface for standalone data logging.
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3. Disconnect your interface device from your computer and connect it to the 
vehicle.

4. Use the buttons on the device to start and stop logging. 

NOTE: The MPVI2 and newer interface devices also support programmed start 
and stop triggers based on driving events.

5. Disconnect the device from the vehicle and reconnect to your computer.

6. In VCM, Scanner, retrieve the log files from the device.

VEHICLE PROFILES
Each vehicle make and model has its own unique set of parameters. The list of 
parameters for one manufacturer's vehicles will be completely different than the list 
for a different manufacturer's vehicles. Moreover, some vehicles that share a make 
and model may support different parameters and channels if their controllers have 
different operating system IDs.

When you connect to a new vehicle, VCM Suite will create and store a new "Vehicle 
Profile" in order to save the channel and parameter setup you implement for that 
vehicle. When you connect to the vehicle again, the correct profile will be auto-
matically selected.

(VCM Scanner version 4.13 and later) If a vehicle is located remotely, you can obtain 
its profile from a user who has access to the vehicle. This allows you to create a 
channel configuration for remote customers. There are two ways to do this:

￭ Profiles can be saved to file and exchanged between users of VCM Scanner. See 
Saving a Vehicle Profile to File (Page 41) for instructions.

￭ Profiles can be imported from a data log performed on the vehicle. See Importing a 
Vehicle Profile from a Data Log (Page 43).
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NOTE: If a vehicle misreports or doesn't report its operating system ID or VIN, it 
may be necessary to manually enter these in the vehicle profile in order to help 
VCM Scanner load the appropriate parameter set. See Manually Entering an OS 
ID or VIN (Page 40).

When you are not connected to a vehicle, you can switch between profiles so that 
VCM Scanner loads the parameter set for the vehicle you wish to work with. See 
Selecting a Stored Vehicle Profile (Page 41).

NOTE: Only OBD channels are saved in vehicle profiles. Since external channels 
are independent of the vehicle, they will be available with all vehicles

CREATING A VEHICLE PROFILE

A vehicle profile is created automatically the first time you establish a data connection 
to a new vehicle. If you want to customize channel setup, connect to the vehicle 
briefly before you begin and poll the vehicle for the latest parameters. This helps 
ensure that VCM Scanner displays an accurate list of parameters available for your 
vehicle.

Follow these steps:

1. Physically connect your laptop to the vehicle. See Connecting to a Vehicle (Page 
23).

2. If VCM Editor is open, close it now.

3. Open VCM Scanner.

4. Turn the vehicle ignition to a position other than OFF. (The engine can be running 
or stopped. But, the vehicle must supply power to the OBD-II port.)

5. Click the  icon in the toolbar to open a data connection to the vehicle.

6. When VCM Scanner has finished connecting, select Vehicle > Repoll for 
Supported Parameters in the menu bar. This will update the vehicle profile with 
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any additional parameter changes not included in the default profile for the type 
of vehicle you are connected to. 

NOTE: We recommend you check for DTCs before you begin tuning a new 
vehicle. This is a good time to do so. See Reading and Clearing DTCs (Page 29) 
for instructions.

7. If desired, you can now click  to close the data connection and then disconnect 
your laptop from the vehicle.

I STILL SEE ONLY SAE PARAMETERS!

There are a couple of reasons that you might stil l be limited to SAE parameters after 
the vehicle profile has been created:

￭ The vehicle is not supported by VCM Suite. 

￭ The vehicle is not reporting its VIN or the OS IDs of its controllers correctly. In 
most cases, this means that the operating system has been scrambled for security.

For vehicles that are not correctly reporting VIN or OS ID, try the following:

￭ If you know the vehicle's actual VIN or the actual OS IDs of its controllers, you can 
enter them manually. See Manually Entering an OS ID or VIN (Page 40).

￭ Define "fallback" OS IDs that will apply to any vehicle whose profile is missing an 
OS ID or has an incorrect OS ID. But, these are not vehicle-specific. See Advanced 
Channel Properties (Page 94).
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MANUALLY ENTERING AN OS ID OR VIN

Each operating system for vehicle controllers supports its own unique set of 
parameters. VCM Scanner needs the correct operating system IDs for your vehicle's 
controllers to load parameter definitions that are appropriate for the vehicle.

If the vehicle does not properly report its VIN or the operating system ID for one of its 
controllers, VCM Scanner will be unable to determine what parameter definitions to 
load. In most cases, this means that the operating system has been scrambled for 
security.

To address this issue, manually enter the correct OS IDs and VIN in the vehicle profile. 
Follow these steps:

1. In the menu bar, select Vehicle > Vehicle Profiles > Vehicle Profile Editor . The 
Vehicle Profile Editor window appears.

2. In the left column, select the vehicle profile for which you need to manually enter 
values.

3. In the right column, enter the values you wish to define manually.
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NOTE: You can also define "fallback" OS IDs that will apply to any vehicle whose 
profile is missing an OS ID or has an incorrect OS ID. But, these are not vehicle-
specific. See Advanced Channel Properties (Page 94).

SELECTING A STORED VEHICLE PROFILE

The correct profile will be automatically selected when you connect to a vehicle. 
When you are not connected, you can manually select a vehicle profile:

1. In the menu bar, select Vehicle > Vehicle Profiles . A submenu that lists all of the 
stored vehicle profiles is displayed.

2. Select the profile for the vehicle you want to work with.

SAVING A VEHICLE PROFILE TO FILE

NOTE: This feature requires VCM Suite version 4.13 (or later).

Loading and saving vehicle profiles allows tuners who do not have direct access to a 
vehicle they are tuning to load the correct vehicle profile. This allows the tuner to 
create a channel configuration for a remote customer.

To save a vehicle profile to file:

1. In the menu bar, select Vehicle > Vehicle Profiles > Vehicle Profile Editor . The 
Vehicle Profile Editor window appears.
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2. In the left column, select the vehicle profile that you wish to save.

3. Click .

4. Enter a file name and click Save .

To load a profile that has been saved to file:

1. In the menu bar, select Vehicle > Vehicle Profiles > Vehicle Profile Editor .  The 
Vehicle Profile Editor window appears.

2. Click .

3. Browse for and select the vehicle profile you want to open.

4. Click Open .
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IMPORTING A VEHICLE PROFILE FROM A DATA LOG

NOTE: This feature requires VCM Suite version 4.13 (or later).

Vehicle profiles can be imported from a log that was generated on the vehicle. This is 
useful if you do not have access to the vehicle, but do have a log file generated on it.

To import a vehicle profile:

1. In the menu bar, select Vehicle > Vehicle Profiles > Vehicle Profile Editor . The 
Vehicle Profile Editor window appears.

2. Click .

3. Browse for and select the log file that contains the desired vehicle profile.

4. Click Open .
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Standalone Data Logging lets you log data directly to internal storage of your MPVI Pro, 

MPVI2/2+, or MPVI3 without being tethered to a laptop. It is now easier than ever to 
collect data while driving. Once the feature is configured, you can start and stop 
recording with the simple press of a button.

MPVI PRO STANDALONE DATA LOGGING
The standalone data logging feature of the MPVI Pro is available for late model GM 
vehicles only.

SETUP

Follow the steps below to set up the standalone datalogging feature for the first time 
on a new vehicle or when switching from another vehicle:

1. Put the vehicle's ignition in the ON/RUN state

2. Connect the MPVI Pro to your vehicle's OBD-II port and to your laptop's USB port.

3. Open VCM Scanner.

4. Click the  icon in the toolbar.

5. Ensure that channels that you wish to log are listed in the Channel display (add or 
delete channels as necessary).

6. (Optional) Click  to save your channel configuration for later use.

7. In the menu bar select Vehicle > MPVI Pro Data Logging . The MPVI Pro Standalone 
Data Logging Functions window appears.
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8. Click Write Config . This will write your current channel configuration to the MPVI 
Pro.

NOTE: This will erase any current logs you have saved in the unit.

9. Disconnect the MPVI Pro's USB cable from your laptop.

GENERATING A LOG

The interface can store up to 32 individual logs if they are small, or about 80 minutes 
of data. However, the actual l imits vary depending on the vehicle you are connected 
to and the number of bytes per frame you are recording.

1. Start the vehicle (if not already running).

2. To start recording, press and hold the Record button on the MPVI Pro for 2 
seconds.
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3. When you are finished, press and hold the Stop button for 2 seconds to stop 
recording.

CAUTION: Always use the stop button to halt the logging process. Powering 
down the unit while it is recording or while the Busy LED is lit during a stop 
request will cause the current log to become corrupted.

INSERTING A MARKER

To insert a marker while recording, press the Record button for 1 second. The Busy 
light will blink, indicating a marker has been inserted into the recorded data.

After a marker has been added, there is a 2 second delay before you can add another 
marker.

NOTES

￭ All button sequences take 1 second to validate.

￭ The Record light will blink when you have used 90% of the memory, or have about 
6 minutes of space for data left on the interface.

￭ The ERR light will flash after a record request if the interface could not establish 
communications with the vehicle. The configuration setup is vehicle specific and 
may require you to program a new configuration for the vehicle you are logging.

￭ The ERR light will l ight solid if a configuration is not programmed, the interface is 
full, or a corrupt log location has been found. 

GETTING INFO FROM THE DEVICE

Click the Get Info button in the MPVI Pro Standalone Data Logging Functions window 
to display the following information:

￭ VIN and operating system ID of vehicle most recently logged.

￭ The percentage of log data mem used.

￭ Logs on the device will be listed in the left column.
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RETRIEVING LOG FILES FROM THE DEVICE
1. Connect your MPVI Pro to your computer.

2. Select Vehicle > MPVI Pro Data Logging . The MPVI Pro Standalone Data Logging 
Functions window appears.

3. If you want to retrieve all logs from the device:

￭ Click Read All Logs .

If you want to retrieve a particular log:

a. Click Get Info to retrieve the list of logs on the device.

a. In the left column, select the log you want to retrieve.

b. Click Read Selected .

NOTE: Retrieving logs will not erase them from the device.

ERASING LOGS FROM THE DEVICE

To erase all logs currently stored in the interface, hold the Record and Stop buttons 

for 2 seconds. The Busy LED will blink until all logs are erased.

This can also be done in VCM Scanner:

1. With your MPVI Pro connected to your computer, select Vehicle > MPVI Pro Data 
Logging . The MPVI Pro Standalone Data Logging Functions window appears.

2. Click the Erase Logs button.

NOTE: Neither method will erase your channel config from the device.
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MPVI2, 2+, AND 3 STANDALONE DATA LOGGING
The Standalone Data Logging feature for these newer interface devices improves on 
the MPVI Pro version  in a couple of key areas:

￭ It now supports all vehicles that can be programmed by VCM Suite rather than the 
handful of vehicles that were supported by the MPVI Pro feature.

￭ You can now define triggers that automatically start and stop logging. Then, at 
your convenience, evaluate and customize start/stop conditions on your PC or 
laptop.

REQUIREMENTS
￭ MPVI2/2+ with Pro Feature set or MPVI3 .

￭ VCM Scanner 4.9.238 or higher.

￭ MPVI2 must have firmware v3.1.2 or higher.

SETUP
1. Open VCM Scanner.

2. Connect your MPVI2 , 2+, or 3 to your computer with the USB cable.

Page 50



STANDALONE DATA LOGGING

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

3. In the menu bar, select Help > Resync Interface . The firmware will update auto-
matically.

NOTE: If you are using an MPVI2, standalone data logging is only available if 
the device's firmware is v3.1.2 or higher.

4. In the menu bar, select Vehicle > MPVI2 Data Logging .

5. Click the Resync Interface Resources button. It will take 10-15 seconds to update 
your interface device.

6. If you want to send your current channel configuration to the device, click Write 
Channels Config . Otherwise, leave it set to Vehicle Defaults.
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CONFIGURING START TRIGGERS (OPTIONAL)

By default, a short press of the BT button on the device will trigger the start of logging. 
If desired, you can set up triggers to start logging automatically  based on the vehicle's 
acceleration).

1. In the menu bar, select Vehicle > MPVI2 Data Logging .

2. Select the Start/Stop Triggers tab.

3. If desired, select either the Street Car button or the Race Car button near the top 
of the window. This will fi l l in some suggested values for the Sustained Accel-
eration fields. 

4. Configure the fields in the Start Trigger group as desired. You can enter a single 
condition (trigger) or multiple conditions. When using multiple conditions, data 
logging will begin when ANY of the conditions are met. 

￭ Short Button Press. If this box is checked, a short press of the BT button on 
the device will trigger the start of logging. If this box is not checked, a short 
button press will not trigger logging start.

￭ Instantaneous Acceleration. If this field is populated, logging will start when 
the vehicle reaches the specified acceleration. 

￭ Sustained Acceleration. If both of these fields are populated, logging will start 
when the vehicle sustains the specified acceleration for the specified number 

of seconds (for example, 0.05 G for 1 second).
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NOTE: If you are using an OBD extension cable, we recommend not using the 
accelerometer G-forcestart triggers. The interface device is only secure when 
it is plugged directly into the vehicle’s OBD port. If the device is connected via 
a cable, it might move independently of the vehicle’s acceleration. As a result, 
the accelerometer readings might be inaccurate and could result in a false 
trigger.

5. When finished, click the Set Triggers button near the bottom of the window.

CONFIGURING STOP TRIGGERS (OPTIONAL)

By default, a short press of the BT button on the device will trigger the stop of logging. 
If desired, you can set up triggers to start logging automatically  based on the 
sustained acceleration and RPM.

NOTE: Additionally, data logging will stop if there is no movement and zero 
RPM for 1 minute.

1. In the menu bar, select Vehicle > MPVI2 Data Logging .

2. Select the Start/Stop Triggers tab.
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3. If desired, select either the Street Car button or the Race Car button near the top 
of the window. This will fi l l in some suggested values for the RPM fields in the 
OR trigger group. 

4. Fill out the fields in the OR Trigger Group and/or the AND Trigger Group as 
desired. The OR Trigger Group allows you to set numerous conditions. Data 
logging will stop if ANY of these conditions are met. The AND Trigger Group allows 
you to set multiple conditions that must ALL be true in order for the data logging 
to stop.

￭ Short Button Press. If this box is checked, a short press of the BT button on 
the device will trigger the stop of logging. If this box is not checked, a short 
button press will not stop logging.

￭ Sustained Acceleration. If both of these fields are populated, logging will stop 
when the vehicle drops below the specified acceleration for the specified 

number of seconds (for example, 0.05 G for 1 second).

￭ RPM. If both of these fields are populated, logging will stop when the vehicle 
drops to the specified RPM or below for the specified number of seconds.

5. When finished, click the Set Triggers button near the bottom of the window.

GENERATING A LOG
1. Disconnect the interface device from your computer. Also ensure that the device 

is not connected to any application (TDN, TrackAddict, etc.) via Bluetooth® .

2. It can take up to two minutes after you disconnect for the device to be ready for 
standalone data logging. If you need to start a log sooner, you can force it to reset 
by unplugging it from the vehicle's OBD-II port.

3. Plug the device into the OBD-II port of the vehicle you wish to log.

4. Start the engine or place the vehicle on the ON/RUN state without starting the 
engine. This will provide power to the device.

Page 54



STANDALONE DATA LOGGING

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

5. Data logging should start automatically about five to ten seconds after the 
configured trigger conditions are met. Once data logging is fully active, the amber 
OBD light will flash.

NOTE: The first time you log a particular vehicle, allow an additional five 
seconds for the system to initiate. If it takes longer than twenty seconds to 
start, please submit a support ticket and attach a copy of the Infolog.

6. Data logging will stop automatically when the configured stop triggers are met. 
Alternately, pressing the BT button will perform a quick stop and discontinue 
logging data (some devices may require a firmer button press than others).

CAUTION: Do not unplug your interface device without properly stopping 
the data logging. Doing so will result in some loss of data.

NOTES

￭ Do not connect to VCM Suite, TDN, or TrackAddict while Standalone Data Logging is 
running. If you do so, the data logging software will turn off and stop recording. 
Data collected up to that point will be saved.

￭ If the data logging fails during startup (for example, if the vehicle’s ignition is 
turned off), logging will abort and the device will wait for another start trigger. 

￭ During startup, the OBD and Host lights will flash and may occasionally pause. This 
is normal.
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RETRIEVING LOG FILES
1. Open VCM Scanner.

2. Connect your HP Tuners interface device to your computer with the USB cable.

3. In the menu bar, select Vehicle > MPVI2 Data Logging .

4. Select the Log Files tab.

The newest log files will appear at the top of the list. The name will contain the 
sequence number and the VIN.

NOTE: The MPVI2 does not have a persistent clock, so dates will display the 
year 1980 unless you connected to VCM Suite, TDN, or TrackAddict during the 
same power cycle.

5. Select the log file you want and then click Read Selected .

6. Choose a destination folder in which to save the file.
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TROUBLESHOOTING

If you encounter problems, make sure you are using the latest version of the VCM 
Scanner software. We're constantly trying to make the software better.

You can also try the following:

STANDALONE DATA LOGGING IS NOT STARTING (NO LOG FILE CREATED)

1. If you are using an MPVI2 , verify that the firmware has been updated to v3.1.2 or 
higher.

2. Click the Resync Interface Resources button in the MPVI2 Data Logging window.

3. Under Start Triggers, verify that the Short Button Press option is checked and 
enabled. Then, use the BT button to initiate logging manually

4. Ensure that the vehicle’s ignition is ON or the engine is running the entire time.

5. Remove the channels from the channel configuration and try again. Click Erase 
Channels Configbutton in the MPVI2 Data Logging window to reset it to Vehicle 
Defaults.

STANDALONE DATA LOGGING IS NOT STOPPING

1. Under Start Triggers, verify that the Short Button Press option is checked and 
enabled. Use the BT button to initiate logging manually.

2. Remove the channels from the channel configuration and try again. Click Erase 
Channels Configuration in the MPVI2 Data Logging window to reset it to Vehicle 
Defaults.
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A DATA LOG IS CREATED, BUT CHANNEL VALUES ARE BLANK, OR AN ERROR WINDOW 
POPS-UP WHEN OPENING THE FILE

1. Ensure that the vehicle’s ignition is on or the engine is running the entire time.

2. In VCM Scanner, right-click on the channel, navigate to Polling Interval , and 
ensure that it is set to a reasonable frequency.

3. Remove the channels from the channel configuration and try again. Click Erase 
Channels Configuration in the MPVI2 Data Logging window to reset it to Vehicle 
Defaults.

FAQ

ARE ALL CONTROLLERS CURRENTLY SUPPORTED?

Most controllers supported by VCM Scanner are also supported here except for:

￭ JTEC SCI

￭ Ford EEC-V

HOW CAN I ACCESS SUPPORT?

If you encounter problems, see Contacting Customer Support (Page 199) for instruc-
tions on submitting a support ticket.

￭ An Infolog from VCM Scanner your HP Tuners interface device connected to the 
vehicle.

￭ A detailed explanation of the issue. The more specific you can be, the better we will 
be able to help you.

￭ The data log (.hpl) fi le generated (if any).

AFTER UPDATING THE FIRMWARE, THE HOST LED TURNS RED. WHAT SHOULD I DO?

Resync your interface by selecting Help > Resync Interface in the menu bar. 

After a successful resync, the red LED will turn off. Your device should now be ready, 
and you can continue where you left off.
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You can load a saved log file for further review of the captured data. To do so:

1. In the toolbar, click .

2. Select the desired log file.

3. Click Open .

4. Click to begin playback.

NOTE: Due to changes in file format, log files saved in VCM Scanner version 4.13 
(and later) cannot be viewed in older versions of the software.

PLAYBACK CONTROLS
When viewing log files, the following toolbar items control playback:

Begin playback of log file or resume playback of paused log file.

Pause playback.

Select playback speed.
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THE TIMELINE
When you play back a recorded log file, a timeline representing the entire duration of 
the file appears at the bottom of the VCM Scanner window.

SLIDER BAR

The slider on this timeline indicates the moment you are currently viewing. The time 

span covered by the slider corresponds to the time frame shown on the Chart vs 
Time panel. Additionally, if you select  in the Graph panel, the panel will only show 

data from this time span.

The thin blue vertical l ine on the slider bar indicates the exact time index of the data 
displayed on the channels display, on gauges, etc.

MARKERS

If markers were inserted in the log during scanning, they will appear as green vertical 
bars in the timeline. 

NOTE: Inserting and displaying markers requires VCM Suite version 4.13 (or later). 
Support for displaying marker comments has not yet been added to the current 
release.
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ZOOMING IN AND OUT

Use the zoom controls to zoom in on a shorter time frame or zoom out to display a 
longer time frame:

Click this icon to zoom in (show a shorter period of time in more detail).

Click this icon to zoom out (show a longer period of time in less detail).

NOTE: The length of the time frame you are currently viewing is indicated next to  
Zoom under the timeline.

MOVING TO A DIFFERENT TIME INDEX

To move to a different time index in the log file playback, do one of the following:

￭ Move the timeline slider right or left.

￭ Click on a point in the timeline you want to jump to.
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THE DETAILS PANEL
When a log file is open, the Details panel will display information about the logged 
vehicle and the log itself. 

To view the Details panel:

￭ If the Channels list is open, click the Details tab on its bottom edge.

￭ If the Channels list is hidden, click the Details tab on the left edge of the window.

Click the pin icon in the upper-right corner of the panel to auto-hide both the Details 
panel and the Channels list when you are not using them. 
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All data input into VCM Scanner is defined by "channels."

￭ If you want to display any value on any layout display (Gauge/Graph/Chart vs. 
Time), you must have a channel that supplies the data.

￭ If you want to use a Math Parameter, each variable used in the math parameter will 
also require a channel to supply the data.

Many channels are pre-defined (you see some of these in action when you do a quick 
scan without adding channels). However, adding an external sensor input or an input 
based on a parameter that the vehicle's controller does not broadcast will require that 
a channel be added to support the input.

The Channels list displays the currently-defined channels. Use this interface add, 
configure, and remove channels. 

USING THE CHANNELS LIST
The Channels list is used to add, configure, and remove the "channels" that supply data 
to the VCM Scanner application. 

By default, it appears on the left side of VCM Scanner's main window. 
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But, if you click the pin icon in the upper-right corner of the display, it will auto-hide 
when you are not using it. 

Click the Channels tab on the left when you want to see it.

CHANNEL ICONS

The icons in the left column indicate the type of each channel:

A polled parameter. Although the vehicle's controller can provide this 
information, VCM Scanner has to ask the controller to provide it. This adds 
processing load to the system. So, adding a large number of these to the 
channel l ist could potentially slow down the rate at which scan data is received.

A broadcast parameter. The vehicle's controller is constantly broadcasting 
this parameter, whether VCM Scanner asks for it or not. Therefore, adding 
these to the channels list does not impact system performance.

An unsupported parameter. The controller in the current vehicle cannot 
provide this parameter.

An external input. The parameter is provided by an external device (typically a 
sensor) connected to your computer through one of the following:

￭ The computer's serial (or USB) port.

￭ The EIO Interface for an MPVI Pro.

￭ The Pro Link cable for an MPVI2 .

￭ The Pro Link+ cable for an MPVI2+or MPVI3 .

External inputs do not impact system performance.
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DATA LOG VIEW

When  live scanning or when a log file is loaded, the Value column displays the output 
of each channel at the current time index.

NOTE: When this view is displayed, most channel configuration options are not 
available. To configure channels, you must stop live scanning or close the open log 
file.

TOOLBAR

Load channel configuration. Not available in Data Log View.

Save channel configuration.

Add channel. Not available in Data Log View. See Adding Channels (Page 70) 
for detailed instructions.
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RIGHT-CLICK MENU

Right-clicking anywhere in the Channels list will produce a menu that includes the 
following options:

￭ Add Channel. Adds a new channel to the list. Not available in Data Log View. See 
Adding Channels (Page 70) for detailed instructions.

￭ Transform. If a transform can be applied to the channel that you right-clicked on, 
the opens the Transform Selector window. See Transforming a Channel (Page 88) 
for details. Not available in Data Log View.

￭ Units. Change the displayed units for the channel you right-clicked on.

￭ Decimals . Increase or decrease the number of decimal places displayed for the 
channel you right-clicked on.

￭ Polling Interval. Change the polling interval for the channel you right-clicked on. 
Not available in Data Log View.

￭ Move Up. Move the channel you right-clicked on upwards in the list.

￭ Move Down. Move the channel you right-clicked on downwards in the list.

￭ Remove Channel. Remove the channel you right-clicked on. Not available in Data 
Log View.

￭ Remove All Channels . Remove all channels from the list. Not available in Data Log 
View.

￭ Channel Config Advanced Properties. Opens a window which allows you to 
define fallback OS IDs for vehicles that don't correctly report information about 
their controllers. See Advanced Channel Properties (Page 94).

￭ Display Properties. Opens the Channel Display Properties Editor window, which 
allows you configure the theme (colors, fonts, etc.) used by the Channels list.
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ADDING CHANNELS
Data can be collected from many sources. See the links below for instructions on 
adding specific channel types:

￭ The vehicle's OBD-II diagnostics port. All HP Tuners interface devices are capable of 
collecting data from this port. But, the available parameters differ from vehicle to 
vehicle and some will not be sent unless you ask the vehicle  for them. See Adding 
OBD Port Channels (Page 71) for more information.

￭ External analog inputs connected to an MPVI Pro interface. These can be gathered 
through the Extended I/O connector. See Connecting an External Sensor to an 
MPVI Pro (Page 73).

￭ External analog inputs connected to an MPVI2 via an attached Pro Link cable or an 
MPVI2+ or MPVI3 via an attached Pro Link+ cable. Your interface device must have a 
license for the Pro Feature Set. See Adding Pro Link and Pro Link+ Analog Inputs 
(Page 76).

￭ A 500 kbps CAN bus input can be connected via a Pro Link or Pro Link+ cable. Your 
interface device must have a license for the Pro Feature Set. See Adding Pro Link 
and Pro Link+ CAN Bus Inputs (Page 79).

￭ Third party devices that can be connected to the computer's serial port (or a 
USB port with a serial to USB adapter). See Devices That Connect to a Serial Port 
(Page 81).

Page 70



CHANNELS

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

ADDING OBD PORT CHANNELS
1. Connect to the vehicle you wish to define channels for (but do not start scanning).

NOTE: If you have connected to this vehicle before, VCM Scanner will have 
created a vehicle profile for it. Selecting this profile allows you to add 
channels for the vehicle when you are not connected.

2. If the Channels list is not already open, click the tab on the left edge of the screen 
to display it.

3. Click the  icon in the Channels list. The Channel Selector window appears.

4. Browse or search for the channel you wish to add. Channels received through the 
OBD-II port are at the top of the list (all groups except External Inputs). 

Keep the following in mind when selecting a channel:

￭ Channels whose names have a BLUE background have already been added.

￭ If the icon to the left of the channel name has a GREEN background, it is a 
broadcast channel. These channels are preferred because adding them will not 
slow down the retrieval of scanned data.

5. Double-click on the channel you wish to add. The channel should now appear in 
the Channels list.

6. If the channel is a polled parameter that you do not need frequent updates for 
(perhaps because the measured value changes slowly), consider reducing the 
polling frequency to reduce the overall burden on the system. To do this, right 
click on the polled channel  and the select Polling Interval .
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7. If desired, you can adjust the units for the new channel or the number of decimal 
places displayed for it by right clicking on the channel and selecting the cor-
responding menu item.

SCANNER PERFORMANCE OF POLLED PARAMETERS

Polled parameters are parameters that VCM Scanner must ask the vehicle controller 
to provide. Each one of these you add, creates additional processing burden on the 
system and may slow down the rate at which data is reported to you.

￭ In the Channel Selector window, the icons associated with polled channels have a 
WHITE background (not a GREEN one).

￭ Once a polled parameter has been added, the  icon will appear next to it in the 

Channels list.

Broadcast parameters do not suffer from this drawback. These are parameters that 
the vehicle is always sending and require no additional overhead in collecting. Given 
the choice between a Polling and a Broadcast parameter, you should chose the 
Broadcast one. However, not all vehicles support broadcast channels.

Channels based on external inputs (Pro Link, Serial Port, etc...) also do not affect the 
rate at which parameters are gathered from the vehicle.

IMPROVING PERFORMANCE OF POLLED CHANNELS

To improve performance, lower the interval on polled channels that do not require 

great resolution. For example, setting Engine Coolant Temperature to 10 seconds 
might be more appropriate than .1 seconds. This frees up bandwidth space for a 
parameter that might require higher resolution, l ike Spark Advance. 

To do this, right click on the polled channel in the Channel display and the select 

Polling Intervals .
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CONNECTING AN EXTERNAL SENSOR TO AN MPVI PRO

The analog inputs on the MPVI Pro's Enhanced IO connector can be used to attach up 
to four devices (such as many types of wideband sensor) that generate an analog 
output.

ENHANCED I/O CONNECTOR ANALOG INPUTS

The EIO connector provides the following for connecting analog inputs:

￭ Four high impedance, buffered, fi ltered, 10 bit 0-5v analog to digital conversion 
channels that can connect to almost any device.

Input impedance greater than 4 meg ohm. A/D inputs can tolerate short term over 
voltage without damage.

￭ Two ground reference tie points.

The following circuit shows the connection between the 0-5 volt analog output from 
an aftermarket wide band controller or EGT sensor (Exhaust Gas Temperature) using 
the supplied pigtail connector.
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Refer to the manufacturer’s documentation for additional information on connecting 
and configuring their device.

CONNECTING AN ANALOG INPUT

1. Connect the analog signal from the external sensor to one of the four A/D inputs 
on the EIO connector.

2. Connect the ground from the sensor output to the ground on the EIO connector.

3. Ensure that your EIO connector is properly attached to your MPVI interface device.

4. Connect the interface device to a USB port on your computer and to the OBD-II 
port on the vehicle.

5. Open VCM Scanner and connect to the vehicle.

6. If the Channels list is not already open, click the tab on the left edge of the screen 
to display it.

7. Click the  icon in the Channels list. The Channel Selector window appears.

8. Go to External Inputs > MPVI Pro and then double-click on the A/D input that you 
connected the sensor to in Step 1 . 
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9. The selected input should now appear in the Channels list. Right-click on it and 
select Transform . The Transform Selector window appears. This window specifies 
how the raw voltages received through the EIO connector must be transformed 
into usable sensor data.

10. Browse for the sensor you connected in Step 1 . If the sensor appears in the list, 
select it and click OK .

If the sensor does not appear in the list or you need to customize a transform to 
account for a signal/noise offset, you can define the appropriate transform 
manually. See Defining Your Own Transform (Page 90) to complete channel setup.

Channel setup is now complete. It can now be added to gauges, graphs, charts, etc. 
just l ike any other channel. When selecting the parameter to include, use the 

transform you chose in Step 10 .
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ADDING PRO LINK AND PRO LINK+ ANALOG INPUTS

Up to two analog inputs can be added to the data stream received by MPVI2 (via Pro 
Link) and MPVI2+/3 (via Pro Link+). 

NOTE: In order to use this feature, you must have a Pro Feature Set license for the 
interface device you are using the Pro Link / ProLink+ with.

PRO LINK PINOUTS

Wire Color Description

Black GND

Red Analog 1 : 0 - 5 V, 100 Hz Sampling Rate

Blue Analog 2 : 0 - 5 V, 100 Hz Sampling Rate

Orange CAN High

Yellow CAN Low

ADDING AN ANALOG INPUT

1. Connect the analog signal from the external sensor to either the RED wire or the 
BLUE wire on the Pro Link cable.

2. Connect the ground from the sensor output to the BLACK wire on the Pro Link 
cable.

3. Ensure that your Pro Link Cable is properly attached to your MPVI2 (or later) 
interface device.

4. Connect the interface device to a USB port on your computer and to the OBD-II 
port on the vehicle.

5. Open VCM Scanner and connect to the vehicle.
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6. If the Channels list is not already open, click the tab on the left edge of the screen 
to display it.

7. Click the  icon in the Channels list. The Channel Selector window appears.

8. Go to External Inputs > MPVI2 > Pro Link and then double-click on the A/D input 
that you connected the sensor to in Step 1 . 

9. The selected input should now appear in the Channels list. Right-click on it and 
select Transform . The Transform Selector window appears. This window specifies 
how the raw voltages received through the Pro Link cable must be transformed 
into usable sensor data.
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10. Browse for the sensor you connected in Step 1 . If the sensor appears in the list, 
select it and click OK .

If the sensor does not appear in the list or you need to customize a transform to 
account for a signal/noise offset, you can define the appropriate transform 
manually. See Defining Your Own Transform (Page 90) to complete channel setup.

Channel setup is now complete. It can now be added to gauges, graphs, charts, etc. 
just l ike any other channel. When selecting the parameter to include, use the 

transform you chose in Step 10 .
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ADDING PRO LINK AND PRO LINK+ CAN BUS INPUTS

Messages from a 500 kbps CAN bus can be added to the data stream received by 
MPVI2 (via Pro Link) and MPVI2+/3 (via Pro Link+). 

NOTE: In order to use this feature, you must have a Pro Feature Set license for the 
interface device you are using the Pro Link / Pro Link+ with.

PRO LINK PINOUTS

Wire Color Description

Black GND

Red Analog 1 : 0 - 5 V, 100 Hz Sampling Rate

Blue Analog 2 : 0 - 5 V, 100 Hz Sampling Rate

Orange CAN High

Yellow CAN Low

ADDING A CAN BUS INPUT

1. Connect the "high" output from the CAN bus to  the ORANGE wire on the Pro Link 
cable.

2. Connect the "low" output from the CAN bus to  the YELLOW wire on the Pro Link 
cable.

3. Ensure that your Pro Link Cable is properly attached to your MPVI2 (or later) 
interface device.

4. Connect the interface device to a USB port on your computer and to the OBD-II 
port on the vehicle.

5. Open VCM Scanner and connect to the vehicle.
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6. If the Channels list is not already open, click the tab on the left edge of the screen 
to display it.

7. Click the  icon in the Channels list. The Channel Selector window appears.

8. All of the folders after the Serial Port folder in External Inputs contain CAN bus 
inputs (listed by manufacturer). Double-click on the sensor that you want to add. 

NOTE: If the sensor you wish to add is not listed, Contact HP Tuners Support 
to request that it be added.

The selected input should now appear in the Channels list. 
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DEVICES THAT CONNECT TO A SERIAL PORT

VCM Scanner includes support for external sensors that connect directly to a 

computer's RS-232 serial port. 

Years ago, most laptops included such a port. But, the majority of laptops built today 
no longer have them. If your laptop does not have a built in serial port, you will need a 

USB to serial port adapter such as: TRENDnet TU-S9 USB to Serial Converter .

NOTE: Support is limited to specific external sensors that are predefined in the 
software.  If your device has a serial output and you'd like us to add VCM Scanner 
support for it, please contact us.

BEFORE YOU BEGIN

It is important that your computer has the most recent serial port drivers and drivers  
for the USB to serial port adapter. Be sure that it has the latest updates installed.

CONNECTING A SENSOR

1. If your computer does not have a serial port that fits the cable from the device, 
connect the USB to Serial Port adapter to your PC. 

2. Connect your sensor's serial output to the Serial Port connector on your PC or 
USB adapter.

3. Open VCM Scanner and connect to the vehicle.

4. If the Channels display is not already open, click the tab on the left edge of the 
screen to display it.

5. Click the  icon in the Channels display. The Channel Selector window appears.

6. Go to External Inputs > Serial Port . The folders in this group list supported 
sensors by manufacturer.

7. Double click on the sensor that you want to configure.
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8. The selected input should now appear in the Channels list. Right-click on it and 
select Transform . The Transform Selector window appears. This window specifies 
how the raw serial data received  must be transformed to get usable sensor data. If 
an appropriate transform appears in the list, select it and click OK

If the sensor does not appear in the list or you need to customize a transform to 
account for a signal/noise offset, you can define the appropriate transform 
manually. See Defining Your Own Transform (Page 90) to complete channel setup.

Channel setup is now complete. It can now be added to gauges, graphs, charts, etc. 
just l ike any other channel. When selecting the parameter to include, use the 

transform you chose in Step 8 .
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USING CHANNEL SELECTOR

Clicking the  icon at the top of the Channels list opens the Channel Selector.
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CHANNEL SEARCH AND FILTERING

Item Description

1.

Data Type Filters. Click an icon to turn off the display of 
channels with a particular data type. Click again to turn it on. 
Currently-displayed data types have a blue box around them.

Show/hide channels that provide scalar (numerical) data.

Show/hide channels that provide switch data (the current 
selection in a list of possible options)

Show/hide channels whose output is a flag (a simple 
True/False or On/Off indication).

2.

Polled / Broadcast Channel Filters Click an icon to turn off the 
display of either polled or broadcast channels. Click again to 
turn it on. Currently-displayed channel types have a blue box 
around them.

Show/hide polled channels

Show/hide broadcast channels

3.

Sort Order. Click an icon to select the order in which channels 
will be displayed. 

Sort by section

Sort by channel name

Sort by channel ID

4.

Tree Expansion. Collapse or expand the channel tree.

Collapse all items in the list.

Expand all items in the list.
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Item Description

5.

Filter By Channel Name. To filter the tree display by channel 
name, enter the text you wish to search for in the [Text Filter] 
box. The displayed tree items will be dynamically fi ltered as you 
type.

CONTROL MODULE HEADERS

Item Description

6.

Vehicle Control Modules. Each heading that displays the  
icon represents a vehicle control module that can provide data 
via the OBD-II port. From left to right, the text on these 
headings indicates:

￭ The module type (ECM or TCM)

￭ The address of the control module

￭ The model number of the control module

￭ The ID (version) of the module's operating system 

The channels listed under of these headings represent 
information that can be provided by the module. See Adding 
OBD Port Channels (Page 71) for instructions on adding this 
type of channel.
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CHANNEL HIGHLIGHTS AND ICONS

Item Description

7. Already Added. Channels that are displayed with a blue 
background have already been added to the Channels list.

8.

Channel Data Type. The icons in front of each channel name 
indicate the format of the data provided by the channel:

Scalar (numerical data)

Switch (provides the current option selected from a short 
list of possible values)

Flag (an ON/OFF or TRUE/FALSE indication).

9.

Broadcast Channels. Channels whose icons have a green 
background are broadcast channels. These channels are 
preferred because adding them does not increase the 
processing load on the system.

(OBD port channels only. External inputs do not increase 
system load.)

See Adding OBD Port Channels (Page 71) for more information.

EXTERNAL INPUTS

Item Description

10.

Devices that Connect to Your Interface. External devices 
that connect to your HP Tuners interface device are listed 
here. See the following topics for instructions:

￭ Connecting an External Sensor to an MPVI Pro (Page 73).

￭ Adding Pro Link and Pro Link+ Analog Inputs (Page 76).
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Item Description

11.
External Serial Inputs. External devices that connect to your 
computer's serial port are listed here. See Devices That 
Connect to a Serial Port (Page 81) for instructions.

12.

CAN Bus Channels. External CAN bus devices that can be 
connected via the CAN bus inputs on a Pro Link or Pro Link+ 
are listed here. See Adding Pro Link and Pro Link+ CAN Bus 
Inputs (Page 79).

ATTRIBUTES FOR SELECTED CHANNEL

Item Description

13. ID. When an OBD channel is selected above, the channel's 
numerical ID will be displayed here.

14. Type. When an OBD channel is selected above, the channel's 
type will be displayed here.

15. Size. When a polled channel is selected above, the size (in 
bytes) of the channel is displayed here.

16. Sensor. When an OBD channel is selected above, the type of 
sensor the channel will act as is displayed here.
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TRANSFORMING A CHANNEL
Most scalars that come from external inputs can be transformed into other values. 
This can be useful for:

￭ Transforming the voltage of an analog signal into Equivalence Ratio, Air/Fuel Ratio, 
Temperature, Pressure, etc.

￭ Transforming a Serial input Equivalence Ratio into an Air/Fuel ratio

￭ Transforming a raw external input value into a parameter value

BRINGING UP THE TRANSFORM MENU

On the Channel display, you can right click a channel to bring up the menu. If the 
channel supports transformation, you will see an option called "Transform".
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SELECTING YOUR TRANSFORM

The Transform Selector form will show you any transforms that apply to the channel 
you have selected.

For example, if your base channel is a voltage input, the Transform Selector will show 
you transforms that take voltage as the input.

If your transform is not listed in the Transform Selector window, and you would like us 

to add it, please contact our customer support department and we can look into 
adding it to a future build.

Alternately, you can define your own transform. See Defining Your Own Transform 
(Page 90).
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DEFINING YOUR OWN TRANSFORM

If your sensor is not listed in the Transform Selector window, or you must account for 
a signal/noise offset, you can define your own transform. 

1. In the Transform Selector window, select a sensor that is similar to the sensor you 
wish to add. 

2. Click the  button to copy the selected sensor's parameters into the fields at the 
bottom of the window. (This should give you a starting point close to the sensor 
you want to add.)

3. Click the Parameter l ink. The Parameter Selector window appears.

4. Double-click on the parameter that you wish map your sensor output to.

NOTE: The transform will convert the input source into an output of the type 
of the parameter you selected. When adding channels that use this transform 
to your layout displays, you simply add the parameter you specified here.

5. In the dropdown to the right of the Parameter link, select the units for the output 
parameter. 

6. Use the Function fields to specify how the range of values output by the 
connected sensor should be transformed into the range of values for the selected 
parameter. See Defining the Function (Page 91) for more information.

7. Enter a Description for this transform.

8. Click OK .
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The user transform values you input will be stored with the channel, and will be saved 
any time you save your channel config.

DEFINING THE FUNCTION

The Function fields define how the numerical values associated with the input are 
converted to their corresponding output values. In the sample screen above, the 

function is converting values in the range 0-5 (volts) to values in the range 0.62-1.10 
(Lambda).

To define the function, you just need two known input values and their corresponding 
output values. Consult the documentation for the device whose output you are trans-
forming.

Once you have these values, the number to put in the first box can be calculated with 
the following formula:

(Input2 - Input1) / (Output2 - Output1)

If we used the max and min values from the example above, you would get:

(5 - 0 volts) / (1.10 - 0.62 lambda) = 10.41666

To determine the value of the second box, you simply plug either of the two known 
input and output pairs into the resulting equation and solve for the missing value.

In our example, if you insert the 0 volt input and it corresponding output value, you 
get:

 0/10.4166 + X = 0.62 . 

So, X = 0.62 .
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LOADING AND SAVING THE CHANNEL 
CONFIGURATION
It is recommended that you save separate channel configs for common tasks and 
vehicles.

However, you do not need to save your channel configuration every time you make a 
change. VCM Scanner will remember all the changes you make and reload them next 
time you open VCM Scanner.

SAVING THE CURRENT CHANNEL CONFIGURATION

To save the current channel configuration:

1. Click the  icon at the top of the Channels list.

2. Enter a file name and click Save .

Channel configurations are saved as xml and include the following information:

￭ Parameter ID

￭ Parameter Source

￭ Polling Interval

￭ Any Transform (if applied)

LOADING A SAVED CONFIGURATION

To load a channel configuration that you have saved to a file:

1. Click the  icon at the top of the Channels list.

2. Select Open Channel Config .

3. Browse for and select a saved channel config fi le.

4. Click Open .

Page 92



CHANNELS

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

LOADING THE DEFAULT CHANNEL CONFIGURATION

You can load two different default channel configurations for the current vehicle.

1. Either connect to the vehicle for which you wish to load defaults or select its 
vehicle profile.

2. Click the  icon at the top of the Channels list.

3. Select one of the two options described below.

LOAD SAE DEFAULTS

This will load a default set of supported SAE parameters for the current vehicle. These 
will only provide a basic set of parameters.

LOAD VEHICLE DEFAULTS

This will load a default set of supported manufacturer specific and SAE parameters for 
the current vehicle. This will provide the best starting point for most vehicles.
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ADVANCED CHANNEL PROPERTIES
Each controller OS supports its own unique parameters. When you connect to a 
vehicle, VCM Scanner will attempt to identify the OS used by each of the vehicle's 
controllers so that it can then load appropriate parameter definitions.

The Channel Config Advanced Properties window allows you to specify "fallback" and 
"override" OS IDs in order to tell VCM Scanner what parameter definitions it should 
load in certain situations.

To open this window, right-click on the Channels display and select Channel Config 
Advanced Properties .

NOTE: These settings will persist when you connect to different vehicles. Using 
these settings may limit or break functionality when connecting to different 
vehicles.
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OS FALLBACK

If an OS Fallback is specified for a controller, VCM Scanner will use the fallback in the 
following situations:

￭ The vehicle doesn't report its OS ID and there is no user-defined OS ID specified in 
the vehicle profile.

￭ Th vehicle reports its OS ID or there is a user-defined OS ID specified in the vehicle 
profile, but VCM Scanner can't find parameter definitions for the OS ID indicated.

NOTE: Vehicle profiles and fallback properties are the preferred methods for 
helping VCM Scanner load parameter definitions. OS Overrides are a far more 
extreme solution.

OS OVERRIDE

If an OS Override is specified for a controller, VCM Scanner will always load the 
parameter definitions for the specified OS for all vehicles.

￭ The OS ID reported by the vehicle (if any) will always be ignored.

￭ User-specified OS IDs specified in the vehicle profile (if any) will also be ignored.

CAUTION: Take care when using these as it will severely limit the trans-
portability of your channel configuration. This may also severely limit VCM 
Scanner capabilities when you connect to different vehicles.

When an override is set, you will see an indication that says Definition Overrides Set :
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MPVI INPUTS AND OUTPUTS
The standard MPVI interface supports defining channels based on parameters 
received through the vehicle's OBD-II port. 

If you have an MPVI Pro interface, the Enhanced IO interface can be used to attach up 
to four devices that generate an analog output. See Connecting an External Sensor to 
an MPVI Pro (Page 73) for details.

NOTE: The EIO interface also includes two outputs (pins 7 and 8) that were 
designed to control external devices such as LEDs and relays. However, this 
function is no longer supported by VCM Scanner.
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MPVI2, MPVI2+, AND MPVI3 INPUTS
In addition to channels based on parameters received through the vehicle's OBD-II 
port, these input devices allow you to create channels for the following data sources:

￭ External analog inputs connected to an MPVI2 via an attached Pro Link cable or an 
MPVI2+ or MPVI3 via an attached Pro Link+ cable. Your interface device must have a 
license for the Pro Feature Set. See Adding Pro Link and Pro Link+ Analog Inputs 
(Page 76).

￭ A 500 kbps CAN bus input can be connected via a Pro Link or Pro Link+ cable. Your 
interface device must have a license for the Pro Feature Set. See Adding Pro Link 
and Pro Link+ CAN Bus Inputs (Page 79).

NOTE: VCM Scanner also lists the HP Tuners Expander Hub as an input option for 
these interface devices. This device is not available at the time of this writing.
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Layouts specify the arrangement of panels that appear in the main display area of 
VCM Scanner. There are three types of panel that can be included here. All of them 
present live vehicle data or data from a log file in graphical formats that may be useful 
for analysis.
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Item Name Description

1 Gauge Panel

Gauge panels represent sensor data 
and/or PIDs as gauges in a cluster. 

See Gauge Panel (Page 106) for 
information on using and customizing 
these panels.

2 Graph Panel

Graph panels represent sensor data 
and/or PIDs in a table format. This can 
be useful if you are gathering sample 
data to populate a table in VCM Editor. 

See Graph Panel (Page 118) for usage 
and customization instructions.

3 Chart vs. 
Time Panel

This type of panel charts the value of 
sensor outputs or PIDs over time. 

See Chart vs. Time Panel (Page 139) for 
usage and customization instructions.

NOTE: All panels are highly configurable. As long as you have channels setup to 
supply the data, they can display whatever performance and/or troubleshooting 
data you need to see.
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CUSTOMIZING LAYOUTS
You can do the following to customize a layout:

￭ Remove a panel by clicking on the X in its upper-right corner.

￭ Add a panel by selecting Layout > Add to Layout in the menu bar.

￭ Resize panels by clicking and dragging the border between two panels.

￭ Move the panels around on the display. See Arranging Layouts (Page 104) for 
details.

￭ To customize the contents of any panel, right-click on the panel you wish to 

customize and then choose the Layout option. See the sections on the individual 
panel types for detailed instructions.

NOTE: If you want to add a displayed value to any panel, you must provide an 
input on the Channels display, or create a math parameter to supply the data. 
Adding parameters to any layout display will not automatically add them to 
the Channels display.

￭ To customize the styling of any panel, right-click on the panel you wish to 

customize and then select Display Properties . See the sections on the individual 
panel types for detailed instructions.

SAVING A LAYOUT
To save the current layout, including panel size and position, as well as any cus-
tomization you have done to the individual panels:

1. In the toolbar, select .

2. Enter a name for the layout file and click Save .
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LOADING A SAVED LAYOUT
To load a layout you have saved to file:

1. In the toolbar, select .

2. Select Open Layout .

NOTE: Layout files that you have recently used are listed below this item. 
Selecting one of these is a shortcut to loading it.

3. Browse for the saved layout file and click Open .

LOADING A DEFAULT LAYOUT
There are a number of pre-defined layouts listed in the menu bar. To open one of 
these layouts:

1. In the menu bar, select Layout > Default Layouts .

2. Select one of the listed layouts.
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ARRANGING LAYOUTS
Panels can be moved around on the display by clicking and dragging the tabs at the 
top of each panel:

1. Click on the tab at the top of the panel you want to move.
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2. Drag the mouse pointer to the area that you wish to move the panel to. A target 
icon like the one below appears in the center of the panel you are hovering over. 

3. Drag the mouse pointer onto one of the five segments of the target icon and 
release the mouse button. The segment selected determines where the panel will 
be located:

￭ Center - moved panel will take up the entire space used by the target panel.

￭ Left - panel will be moved to the space used by the left half of the target panel.

￭ Right  - panel will be moved to the space used by the right half of the target 
panel.

￭ Top - panel  will be moved to the space used by the top half of the target panel.

￭ Bottom -  panel will be moved to the space used by the bottom half of the 
target panel.
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GAUGE PANEL
The Gauge panel can be configured to show a gauge based on any numerical stream 
of data provided by the vehicle's controllers and any external inputs you 
connect. Moreover, the layout and the theme of the panel is highly customizable.

EDITING THE GAUGE LAYOUT

To add, remove, configure, or load and save gauges:

1. Right-click on the gauge display.

2. Select Gauges Layout . 

See Gauge Display Layout Editor (Page 107) for more information.

Page 106



LAYOUTS

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

CHANGING THE GAUGE PANEL THEME

To change colors, fonts, l ine weights and other elements of the gauge panel's theme:

1. Right-click on the gauge display.

2. Select Display Properties . 

See Gauge Display Properties Editor (Page 116) for more information.

RESETTING GHOST GAUGES (PEAKS)

Gauges can be configured to show "ghost" pointers that indicate the maximum and/or 
minimum values that the gauge has reached. 

To reset all the ghost pointers in the panel:

1. Right-click on the gauge display.

2. Select Reset Peaks . 

GAUGE DISPLAY LAYOUT EDITOR

The layout editor is used to add, remove. and configure individual gauges. To open 
this window:

1. Right click on the gauge display.

2. Select Gauges Layout .

NOTE: Changes take effect immediately (without saving your changes to file). 
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ADDING A GAUGE

1. Click  and select the type of gauge you wish to add:

￭ Add Round Analog Gauge

￭ Add Vertical Bar Gauge

2. Click the Parameter l ink. The Parameter Selector window appears.

3. Double-click on the parameter whose value you wish to display in the gauge. A 
blank gauge should now appear on gauge display.

NOTE: Your channels list must include a channel that provides the selected 
parameter. If you don't have a channel to do this, VCM Scanner won't query 
the vehicle or the external input for this data and may not know how to 
transform the raw data received into meaningful values. See Selecting a 
Parameter (Page 151) for more information.
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4. Complete gauge setup by configuring the gauge's parameters .

EDITING AN EXISTING GAUGE

To modify a gauge that is already included in this layout: 

1. Select the name of the gauge in the column on the left.

2. Modify the gauge parameters displayed on the right.

TOOLBAR

Open Individual Gauges or All Gauges

To save the gauge selected in the left column, click this icon and then 
choose Selected Gauge .

To save all gauges in the current layout, click this icon and the choose All 
Gauges .

Default gauge layouts

Add a new gauge. To complete gauge setup, you must configure the gauge's 
parameters .

Delete the gauge selected in the column on the left.

Duplicate the gauge selected in the column on the left.

Move the gauge selected in the left column upwards in the list. When gauges 
overlap, gauges that appear higher in the list are displayed behind gauges 
that appear lower in the list.

Move the gauge selected in the left column downwards in the list. When 
gauges overlap, gauges that appear lower in the list are displayed in front of 
gauges that appear higher in the list.

Undo all changes to this gauge layout.
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GAUGE PARAMETERS

The parameters on the right side of the Gauge Display Layout Editor can be broken 
down into five groups:

￭ Basic Parameters

￭ Gauge Ticks (Numbering)

￭ Peaks (Ghost Pointers)

￭ Ranges (Color Bars)

￭ Location and Size

BASIC PARAMETERS

Parameter Description

Label
The gauge name that will be displayed on screen. It 
appears at the bottom of round gauges and just 
above bar gauges. 

Type Select the type of gauge: ell ipse or vertical bar.

Parameter
Click this l ink to select the signal whose output the 
gauge will display.

Unit

Once the Parameter is selected, use this dropdown to 
select the units for this parameter. For example, a 
speedometer can display mph or km/h. On round 
gauges, the selected unit type will be displayed in the 
top half of the gauge.

Decimals

This specifies the number of decimal places used 
when displaying the digital readout of the gauge 
reading. On round gauges, this is the large number in 
the center of the gauge. On bar gauges, the number 
appears below the gauge.
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Parameter Description

Filter
The length of time entered here (if any) specifies how 
often VCM Scanner should update this gauge.

GAUGE "TICKS" (NUMBERING) 

To set up the numbering on the face of the gauge, configure the following 
parameters:

Parameter Description

Limits - Max
The highest value that the gauge will be able to 
display. For example, the Speedometer above has a 
Max of 160 .

Limits - Min
The lowest value that the gauge will be able to display. 
For example, all three gauges above have a Min of 0 .

Major Ticks - 
Count

How many numbers appear on the outside of the 
gauge? For example, the RPM gauge above has 8 
numbers (0 to 7).

Major Ticks - 
Factor

The raw value will be divided by this number to 
produce the numbers on the gauge face. For 
example, the RPM gauge above has a Factor of 1000 
so that it displays 0 , 1 , 2 . . . rather than 0 , 1000 , 2000 . . .
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For round gauges, the following additional parameters can be configured:         

Parameter Description

Minor Ticks - 
Count

The number of ticks between each number on the 
gauge.

Ell ipse Properties 
- Arc Start

The position (in degrees) of the lowest value on the 
gauge. Both round gauges start at 135 degrees. (0 
degrees is at 3 o'clock).

Ell ipse Properties 
- Arc Sweep

How far around the edge of the gauge (in degrees) 
does the numbering go?  Both round gauges above 
use a value of 270 degrees (the numbers go 3/4 of the 
way around the gauge, clockwise from the Arc Start).
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PEAKS (GHOST POINTERS)

Gauges can display a ghost pointer to represent the highest and/or lowest value that 
the gauge has reached. 

Parameter Description

Draw Max
If this box is checked, the gauge will display a ghost 
pointer at the highest value it has recorded (since the 
last reset).

Draw Min
If this box is checked, the gauge will display a ghost 
pointer at the lowest value it has recorded (since the 
last reset).

NOTE: The ghost pointers can be reset by right clicking on the gauge display and 
then selecting Reset Peaks.

Page 113



VCM SCANNER USER GUIDE

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

RANGES (COLOR BARS)

Some gauges (such as the RPM gauge in the default layout) have color bars along the 
outer edge. To configure a color bar, fi l l out the Start, End and Level values in a single 
row of the Ranges section. Each color bar will use one row in this section.

Parameter Description

Start
The lowest value in the range covered by this color 
bar. 

End
The highest value in the range covered by this color 
bar.

Level

Select a number here to specify the color of the bar. 
By default, the colors are:

￭ 1 - green

￭ 2 - yellow

￭ 3 - red

NOTE: The available colors can be adjusted globally (For all gauges) rather than for 
an individual gauge. See the Scales tab of the Gauge Display Properties Editor.
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LOCATION AND SIZE

Parameter Description

Left
The distance of the left edge of the gauge from the 
left edge of the gauge panel. This is entered as a 
percentage of the total width of the gauge panel.

Top
The distance of the top edge of the gauge from the 
top edge of the gauge panel. This is entered as a 
percentage of the total height of the gauge panel.

Width
The width of the gauge, entered as a percentage of 
the total width of the gauge panel.

Height The height of a gauge.
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OVERLAPPING GAUGES

Gauge configuration is flexible enough to replicate fairly complex cluster layouts in 
real vehicles. In addition to just moving the gauges around and resizing them, you can 
position gauges so that they overlap each other. When overlapping gauges, you may 
also want to adjust gauge stacking order and the Ell ipse Properties of each gauge.

Gauge Stacking Order

Gauges that appear lower in the list on the left side of the Gauge Display Layout Editor 
will be displayed in front of the gauges that appear higher in the list. To change a 
gauge’s position in the list.

1. Select the gauge in the list.

2. Click  and/or  to move the gauge up and down the list.

Ellipse Properties

On round gauges, the ellipse properties fields (described under Gauge "Ticks" above) 
can be used to make sure that the gauge numbers appear only on the portion of the 
gauge face that is not covered by other gauges.

GAUGE DISPLAY PROPERTIES EDITOR

The Display Properties Editor is used to configure the theme of the gauge display 
(colors, fonts, l ine widths, etc). To open this window:

1. Right click on the gauge display.

2. Select Display Properties .

NOTE: Changes take effect immediately (without saving your changes to file). 
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TOOLBAR

Load Theme

Save Theme

Load Default Theme

 Undo theme changes
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GRAPH PANEL
The Graph panel plots all values of a specific parameter measured during the entire 
session. There are two types of graph that can be displayed here:

￭ Tables: plot the observed values of a selected parameter as a function of two 
other selected parameters. 

See Graph Panel Tables (Page 120) for more information.

￭ Histograms: (VCM Suite 4.13 and later) plot the distribution of observed values for 
a single parameter.

See Graph Panel Histograms (Page 122).
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SETTING UP THE DISPLAYED GRAPHS

To add, remove, configure, or load and save graphs:

1. Right-click on the graph panel.

2. Select Graphs Layout . 

See Graph Display Layout Editor (Page 124) for more information.

CHANGING THE GRAPH PANEL THEME

To change colors and fonts that apply to the all tables in the graph panel:

1. Right-click on the graph panel.

2. Select Display Properties . 

See Graph Display Properties Editor (Page 137) for more information.

HOT KEYS

Keypad 1 - 0 View the table or histogram with the selected number (press 1 to 
view the first graph in the list).

Page Up / Page 
Down

Cycle through the table and histograms in the list.

CNTRL+C (When viewing a table) copy the data in the selected cells to the 
clipboard.
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GRAPH PANEL TABLES

This type of graph can be particularly useful if you set up the tables to match tables 
you want to tune in VCM Editor. Having a matching table allows you to:

￭ Gather sample data to use in the table based on the actual behavior of the vehicle.

￭ See what might need to be adjusted in a table based on the real time corrections 
being made by the controller. (For example: observing short term fuel trims can 
tell you how much you might need to tweak the fuel/air mix.)

Item Description

1.
Graph Selection. A list of graphs that have been set up for this 
panel. Click the name of the graph you want to display.
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Item Description

2.

Cell Data Set Selection. These icons select the type of data 
displayed in the cells:

Show the highest value observed for each cell.

Show the lowest value observed for each cell.

Show the average of all observed values for each cell. (This 
is the most commonly-used option.)

Show the last observed value for each cell.

Show the hit count for each cell.

3.

Time Range Selection. These icons above the graph select the 
time range for which data is graphed:

Show data from entire length of the recording.

Show only the data gathered during the time frame 
displayed in the Chart vs. Time panel.

4.
Current Value. The highlighted cell contains the value for the 
tracked parameter at the current time index.

COPYING TABLE DATA TO VCM EDITOR

If you have set up a table to mimic a corresponding table in VCM Editor, you can copy 
the collected performance data from this table to the original table in VCM Editor. 
Follow these steps:

1. In VCM Scanner, select the cells whose data you wish to copy.

2. Right-click on the table and select Copy with Axis .

3. Open VCM Editor and navigate to the original table.

4. Open the table in Table Editor.

5. Right-click on the table and select Paste Special .
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GRAPH PANEL HISTOGRAMS

NOTE: This feature requires VCM Suite version 4.13 (or later).

This type of graph plots the distribution of observed values for a single parameter.

Item Description

1.
Graph Selection. A list of graphs that have been set up for this 
panel. Click the name of the graph you want to display.
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Item Description

2.

Time Range Selection. These icons above the graph select the 
time range for which data is graphed:

Show data from entire length of the recording.

Show only the data gathered during the time frame 
displayed in the Chart vs. Time panel.

3.
Percentage of Distribution. Each bar represents the 
percentage of time that the graphed parameter was observed 
with the indicated value.

COPYING HISTORGRAM DATA TO VCM EDITOR

If you have set up a histogram to mimic a corresponding table in VCM Editor, you can 
copy the collected performance data from this graph to the original table in VCM 
Editor. Follow these steps:

1. In the left column, select the histogram whose data you wish to copy.

2. Right-click on the historgram and select Copy with Axis .

3. Open VCM Editor and navigate to the original table.

4. Open the table in Table Editor.

5. Right-click on the table and select Paste Special .
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GRAPH DISPLAY LAYOUT EDITOR

The layout editor is used to add, remove. and configure individual graphs. To open this 
window:

1. Right click on the graph display.

2. Select Graphs Layout .
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NOTE: Changes take effect immediately (without saving your changes to file). 

TOOLBAR

Open Individual Graphs or All Graphs

To save the graph selected in the left column, click this icon and then 
choose Selected Graph .

To save all graphs in the current layout, click this icon and the choose All 
Graphs .

Load one of the pre-defined graph layouts.

Add a new graph. To complete graph setup, you must configure the graph's 
parameters .

Delete the graph selected in the column on the left.

Duplicate the graph selected in the column on the left.

Move the graph selected in the left column upwards in the list. 

Move the graph selected in the left column downwards in the list. 

Undo all changes to this graph layout.
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ADDING A TABLE

1. Click  and select Add Table .

2. Click the Parameter l ink. The Parameter Selector window appears. See Selecting a 
Parameter (Page 151) for more information on this window.

3. Double-click on the parameter whose values will be mapped in the cells of the 
new table. A blank table should now appear on the Graph panel. 

NOTE: Your channels list must include a channel that provides the selected 
parameter. If you don't have a channel to do this, VCM Scanner won't query 
the vehicle or the external input for this data and may not know how to 
transform the raw data received into meaningful values. 

4. Complete graph setup by configuring the graph's remaining parameters .

ADDING A HISTOGRAM

1. Click  and select Add Histogram .

2. Click the Parameter l ink in the Column Axis group. The Parameter Selector 
window appears. See Selecting a Parameter (Page 151) for more information on 
this window.

3. Double-click on the parameter whose distribution will be plotted by this 
histogram.

NOTE: Your channels list must include a channel that provides the selected 
parameter. If you don't have a channel to do this, VCM Scanner won't query 
the vehicle or the external input for this data and may not know how to 
transform the raw data received into meaningful values. 

4. Select the Unit for the parameter.
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5. In the Values box, enter the values for the column labels displayed on the bottom 
of the histogram, separated. For example, entering "400 800 1200 " would create 
histogram with three bars centered on 400 , 800 , and 1200 .

6. Enter a name for this histogram in the Label field.

7. If you want to filter the data included in the histogram, define the filter in the 
Function box. See Expression Filtering (Page 133) for more information in defining 
filter functions.

EDITING AN EXISTING GRAPH

To modify a graph that is already included in this layout: 

1. Select the name of the graph in the column on the left.

2. Modify the graph parameters displayed on the right.

GRAPH PARAMETERS

The parameters on the right side of the Graph Display Layout Editor can be broken 
down into five groups:

￭ Basic Parameters

￭ Filtering

￭ Shading

￭ Column Axis

￭ Row Axis

BASIC PARAMETERS

Parameter Description

Label
The table or histogram name that will be displayed in 
the left column of the Graph panel. 
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Parameter Description

View

(Tables only) Select the default type of data displayed 
by this table's cells:

￭ Max: Show the highest value observed for the cell.

￭ Min: Show the lowest value observed for the cell.

￭ Average: Show the average value observed for the 
cell.

￭ Last: Show the last observed value for the cell.

￭ Count: Show the hit count for the cell.

NOTE: When viewing this table in the Graph 
panel, this selection can be overridden by the 
icons above the table.

View Zoom Data 
Only

When this box is checked, the table or histogram will 
display only data gathered during the time frame that 
you select in the Chart vs. Time panel.

If this box is left unchecked, the table or histogram 
will show data gathered during the entire length of 
the recording.

NOTE: When viewing this table or histogram in 
the Graph panel, this selection can be 
overridden by the icons above the graph.

Parameter
(Tables only) Click this l ink to select the signal (sensor 
or PID) whose output values will be mapped in the 
cells of the new table.
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Parameter Description

Unit
Once the Parameter is selected, use this dropdown to 
select the units for this parameter. For example, 
Spark Advance can be displayed in degrees or radians. 

Decimals
(Tables only) The number of decimal places displayed 
for cell data.

FILTERING

The fields in this group are used to filter out data that should not be included in the 
graph.

Function

If a function is entered here, each frame of data received will be checked against this 
function. 

￭ If the function evaluates as TRUE for the frame, the data in the frame will be added 
to the graph.

￭ If the function evaluates as FALSE, the data from the frame will NOT be added tot 
he graph.

See Expression Filtering (Page 133) for more information in defining filter functions.

Cell Hits Required

(Tables only) The field is used to specify the minimum number of cell hits required to 
register data on the graph. Entering a higher value here can help remove erroneous 
data by filtering out cells that do not have enough data for accurate feedback. 
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SHADING

Table cells can be colored based on the values they contain. The parameters in this 
section define what values will be colored and what colors will be used. 

Parameter Description

High Value
Cells whose values are equal to or above the number 
entered here will be given the color in the box to the 
right. (Click the box to select a different color.)

Mid Value

Cells whose values are between the Low Value and 
High Value will be colored with lighter shades of the 
two colors selected. 

The value specified here is used to set the value at 
which the colors shift from shades of the Low Value 
color to shades of the High Value Color.

Low Value
Cells whose values are equal to or below the number 
entered here will be given the color in the box to the 
right. (Click the box to select a different color.)
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COLUMN AXIS

The configuration options in this section specify the values displayed on the column 
axis of the table or histogram.

Parameter Description

Parameter
Click this l ink to select the signal (sensor or 
PID) whose output values will be used for the column 
axis of the table or histogram.

Unit The units for the selected parameter.

Header Cell 
Factor 

(Tables only) the header values entered below will be 
divided by this value to determine the values actually 
displayed at the top of each column. 

For example, if the column header value entered is 
1200 and the Header Cell Factor value is 1000 , the 
actual value displayed at the top of the table will be 
1.2 .

Values

The values for the column headers, separated by 
spaces.

NOTE: You can copy the labels from an existing 
table in VCM Editor by right-clicking on the 
original table and selecting Column Axis > Copy 
Labels. Then, right-click on this field and select 
Paste.
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ROW AXIS

(Tables only) The configuration options in this section specify the values displayed on 
the table's row axis.

Parameter Description

Parameter
Click this l ink to select the signal (sensor or 
PID) whose output values will be used for the row axis 
of the table.

Unit The units for the selected parameter.

Header Cell 
Factor

The header values entered below will be divided by 
this value to determine the values actually displayed 

at the left end of each row. 

For example, if the row header value entered is 70 
and the Header Cell Factor value is 10 , the actual 
value displayed at the top of the table will be 7 .

Values

The values for the row headers, separated by spaces.

NOTE: You can copy the labels from an existing 
table in VCM Editor by right-clicking on the 
original table and selecting Row Axis > Copy 
Labels. Then, right-click on this field and select 
Paste.
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EXPRESSION FILTERING

Entering an expression in the Function field of the Graph Display Layout Editor sets a 
condition which must be met for the data to be included in the graph you are 
configuring.

NOTE: Expression filtering, does increase processing overhead, and may not 
perform well on slower devices.

Defining the function for a filter follows the same procedure as the expressions for 
math parameters:

1. Insert variables that represent that output of the sensors and/or PIDs that will be 
included in the calculation.

2. Add supported math operations  to complete the desired calculation.

The completed function must evaluate to TRUE or FALSE (1 or 0). Each frame of data 
received will be checked against this function: 

￭ If the function evaluates as TRUE (1) for the frame, the data in the frame will be 
added to the graph.

￭ If the function evaluates as FALSE (0), the data from the frame will NOT be added to 
the graph.

EXAMPLE

Suppose we want to create a filter that fi lters out throttle values < or = to 50% as well 
as the transitions before and after. To accomplish this, we need a filter expression 
that will return TRUE if ALL of the following conditions are true:

￭ Throttle % > 50

￭ Throttle % has been > 50 for 500 mill iseconds

￭ Throttle % will be > 50 for 500 mill iseconds

Part 1 - Throttle % > 50

1. Click New Variable . The Variable Wizard appears.

Page 133



VCM SCANNER USER GUIDE

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

2. Click the Parameter l ink. The Parameter Selector window appears.

Page 134



LAYOUTS

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

3. Search for throttle position and select (double-click on) the Throttle Position 
sensor in the Generic Sensors group.

4. In the Unit dropdown of the Variable Wizard window, select % .

5. Click OK . The filter expression should now show a text representation of the 
Throttle % variable you just created:

[50090.156]

6. For this first part of our expression, we simply need to make sure Throttle % is > 
50 . So, we just need to add > 50 after our throttle position variable:

[50090.156] > 50

Part 2 - Throttle % has been > 50 for 500 milliseconds

Now, we need to filter out the transitions before this period. To do that, we can use 

the average function to verify that the average throttle % has been over 50 for at least 
500 ms.

1. This second condition has to ALSO be true. So, we add AND to our expression.

[50090.156] > 50 AND 

2. Click New Variable to open the Variable Wizard again.

3. Select the same Parameter and Unit that was selected in Part 1 .

4. In the Special Function box, select Average and enter a Period of 500 ms.
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5. Click OK . Our expression should now look like this:

[50090.156] > 50 AND [50090.156 .avg(500)] 

6. For this period, the throttle position needs to be over 50%. So, we add > 50 to this 
part of the expression as well:

[50090.156] > 50 AND [50090.156 .avg(500)] > 50 .

Part 3 - Throttle % has been > 50 for 500 milliseconds

Now, we need to filter out the transitions after this period. This requires exactly the 

same procedure that we used for Part 2 . However, we will use -500 ms for the period. 

NOTE: Using a negative value for the Period tells VCM Scanner to look at the 
period AFTER the current time index. This works only during playback of recorded 
data streams. When Iive scanning, VCM Scanner can't obtain the specified 
information (it can't look into the future).

So, we add the following to the end of our expression:

AND [50090.156.avg(-500)] > 50

So, the final expression would look like the following:

([50090.156] > 50) AND ([ 50090.156 .avg(500)] > 50) AND ([50090.156 .avg(-500)] > 
50)

NOTE: We've added parentheses to make the expression more readable. But, this 
is optional. The expression will work without them.
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GRAPH DISPLAY PROPERTIES EDITOR

The Display Properties Editor controls the theme of the graph display (color scheme 
and fonts used). To open this window:

1. Right click on the graph display.

2. Select Display Properties .

NOTE: Changes take effect immediately (without saving your changes to file). 
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TOOLBAR

Load Theme

Save Theme

Load Default Theme

Undo theme changes
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CHART VS. TIME PANEL
This type of panel displays line charts of the selected parameters over time. When 
scanning a vehicle, these charts are drawn in real time. During playback of a log file, 
they display a time window surrounding the current time index of the playback.

Item Description

1.

Current Parameter Values. During live scanning, this area 
displays the current values of the parameters being tracked. 
During Playback, it shows the values at the current time index.

If a parameter is stuck at zero or displays no data at all, check 
your channel setup. Either you don't have a channel that 
supplies this data or the vehicle doesn't support it.
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Item Description

2.

Parameter Line Charts. Tracks the value of the displayed 
parameters over time. 

￭ Click  in the toolbar to zoom in and examine a shorter 

time frame in more detail.

￭ Click  to zoom out and view parameters over a longer 

time frame.

￭ During playback of a log file, drag the slider on the timeline 
(Item 5) to move this viewport to a time you wish to 
examine.

3.

Vertical Axis Labels. There are three labels here for each line 
chart (color coded by parameter). The top value  corresponds 
to the top edge of the chart. The middle value corresponds to 
the horizontal l ine through the center. The bottom value 
corresponds to the bottom edge.

4.

Time Index. During playback of a log file, this vertical bar 
indicates the current time index. All data displayed in the layout 
reflects the values at this moment, including:

￭ The specific parameter values in the column to the left.

￭ The readout of gauges in the Gauge panel.

￭ The highlighted value in the Graph panel.

When playback is paused, you can examine the values at a 
specific moment by clicking anywhere on the line charts. The 
bar will move to the position clicked.

5.

Timeline. When playing back a log file, the timeline represents 
the total length of time captured in the log. Drag the slider to 
move to a different time index. Appears only when a log file is 
open.
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SETTING UP SIGNALS AND SIGNAL GROUPS

To add, remove, configure, or load and save signal groups displayed in the Chart vs. 
Time panel:

1. Right-click on the Chart vs. Time panel.

2. Select Charts Layout . 

See Chart Display Layout Editor (Page 141) for more information.

CHANGING THE CHART VS. TIME PANEL THEME

To change colors and fonts that apply to the entire Chart vs. Time panel:

1. Right-click on the Chart vs. Time panel.

2. Select Display Properties . 

See Chart Display Properties Editor (Page 147) for more information.

CHART DISPLAY LAYOUT EDITOR

The Chart Display Layout Editor is used to add, remove, and configure individual 
signals in the Chart vs. Time panel. To open this window:

1. Right click on the Chart vs. Time panel.

2. Select Charts Layout .

NOTE: Changes take effect immediately (without saving your changes to file). 
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ADDING A GROUP

1. Click  and select Add Table .

2. Add the desired signals to the group using the instructions below.
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ADDING A SIGNAL (SERIES) TO A GROUP

1. In the column on the left, select the group that you want to add a signal to.

2. Click .

3. Click the Parameter l ink. The Parameter Selector window appears.

4. Double-click on the parameter whose output you want to display.

NOTE: Your channels list must include a channel that provides the selected 
parameter. If you don't have a channel to do this, VCM Scanner won't query 
the vehicle or the external input for this data and may not know how to 
transform the raw data received into meaningful values. See Selecting a 
Parameter (Page 151) for more information.

5. Complete signal setup by configuring the signal's parameters .

EDITING AN EXISTING SIGNAL (SERIES)

To configure a signal that is already included in this layout: 

1. Select the name of the signal in the column on the left.

2. Modify the signal parameters displayed on the right.
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TOOLBAR

Load all groups, a single group, or a single series.

To save a group whose name is selected in the left column, click this icon 
and then choose Selected Group .

To save all groups in the current layout, click this icon and the choose All 
Groups .

Load one of the pre-defined chart vs. time layouts.

Add a new (empty) chart group. To complete group setup, add the signals 
(series) that would be included in the group.

Delete the chart group selected in the left column.

Add a new signal (series) to the group selected in the column on the left. To 
complete signal setup, you must configure the signal's parameters .

Delete the signal (series) selected in the left column.

Duplicate the signal (series) selected in the column on the left.

Move the signal selected in the left column upwards in the list. 

Move the signal selected in the left column downwards in the list. 

Undo all changes to this chart vs. time layout.
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CHART PARAMETERS

When you select an individual signal (series) in the left column of Chart Display Layout 
Editor, the configurable properties for that signal appear to the right. These 
properties can be broken down into four groups:

￭ Basic Parameters

￭ Limits

￭ Reference Line

￭ Plot

BASIC PARAMETERS

Parameter Description

Label
The name of this signal. This will be displayed in the 
legend on the left end of the Chart vs. Time panel.

Parameter
Click this l ink to select the signal (sensor or 
PID) whose output values will be charted.

Unit
Once the Parameter is selected, use this dropdown to 
select the units for this parameter. For example, 
Speed could be in mph in km/h. 

Decimals
The number of decimal places displayed for this 
parameter on the Chart vs. Time panel.

Filter
The length of time entered here (if any) specifies how 
often VCM Scanner should update this parameter.

LIMITS

These fields define the range of values that will be appear on the chart. If the signal 
produces values outside of this range, those values will be cut off because they would 
be beyond the upper and lower edges of the chart.
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REFERENCE LINE

Parameter Description

Enabled
If this box is checked, a horizontal l ine will be drawn 
through the graph to represent the value specified 
below.

Value The value at which the reference line will be drawn.

PLOT

Click this box to select this signal's color in the Chart vs. Time panel.
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CHART DISPLAY PROPERTIES EDITOR

The Display Properties Editor controls the theme of the Chart vs. Time panel (color 
scheme and fonts used). To open this window:

1. Right-click on the Chart vs. Time panel.

2. Select Display Properties .

NOTE: Changes take effect immediately (without saving your changes to file). 
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TOOLBAR

Load Theme

Save Theme

Load Default Theme

Undo theme changes
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DRIVE CYCLE PANEL

NOTE: This feature requires VCM Suite version 4.13 (or later).

Drive cycles are standardized driving patterns used for testing emissions and fuel 
economy. The Drive Cycle panel provides guidance for the driver when attempting to 
perform one of these tests. Performing a standardized drive cycle can be useful when:

￭ Ensuring that emissions and fuel economy testing of your build complies with 
national and/or local regulation.

￭ If you have recently cleared DTCs, disconnected the vehicle battery, or performed 
other major maintenance, the on board emissions monitors will reset and may 
take several drive cycles to complete their testing. Vehicles will not pass emissions 
testing until these on board tests are completed. Following a standardized driving 
cycle helps to ensure that this testing is completed as quickly as possible.
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PERFORMING A DRIVE CYCLE

Completing a drive cycle requires that the driver accelerate to specific speeds (or 
above) and then maintain those speeds for several minutes. Typically, the driver will 
then be required to decelerate or stop and then accelerate to a specified speed 
multiple times.

It is recommended that you begin the test with a relatively cold engine and proceed 
immediately to an open highway with little to no traffic so that you can accelerate and 
decelerate without worrying about surrounding vehicles.

1. Connect your HP Tuners interface device to your laptop and then connect the 
interface to the OBD-II port on the vehicle to be tested. See Connecting to a 
Vehicle (Page 23) for details.

2. If VCM Editor is open, close it now.

3. Open VCM Scanner.

4. Open a layout that includes a Drive Cycle panel.

5. In the Drive Cycle Test dropdown, select the test that you wish to complete.

6. Turn the vehicle ignition ON. 

7. Click the  icon in the toolbar to open a data connection to the vehicle.

8. When the vehicle is in position to begin the test, click  to start scanning.

9. The white line on the Drive Cycle panel will indicate a target speed. Accelerate to 
the target speed. The green line will indicate the current speed of your vehicle.

10. Continue following the white line for guidance until the drive has been completed.

NOTE: After the drive cycle, you can check to see if the vehicle's emissions 
monitors have completed their self testing in the Diagnostics & Information 
window. See Checking Emissions Monitor Status (Page 32) for details.
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SELECTING A PARAMETER
Parameters are sensor outputs or other signals that may be useful to monitor using 
VCM Scanner. You will need to select a parameter when you do any of the following:

￭ Add a signal to the Chart vs. Time panel.

￭ Add a gauge to the Gauge panel.

￭ Add a table or histogram to the Graph panel (tables require selecting three 
parameters: cell content, column axis, and row axis).

￭ Define a Math Parameter or an Expression Filter . The calculations performed by 
these structures often include multiple parameters.

However, the parameter will not provide data during scanning or playback unless a 
channel has been defined to supply data to it. For example, if your chart, gauge, table, 
or math parameter is tied to "Engine Speed", you must have an "Engine Speed" channel 
in the channel l ist. See Channels (Page 65) for more information.

PARAMETER GROUPS

SPECIFIC PARAMETERS

Specific parameters are tied to a specific channel provided by the vehicle's control 
modules. 

Since the channels that are provided vary from vehicle to vehicle, gauges, graphs, etc. 
that use parameters in this group are often not portable to vehicles with different 
controllers and operating systems than the original vehicle. 

NOTE: If there is a generic sensor of the same type, VCM Scanner will prompt you 
to see if you want to use the generic sensor instead. 
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GENERIC SENSORS

The parameters in this group will work with any channel that provides the type of 
sensor data described. Using these parameters allows much more compatibil ity and 
portability from vehicle to vehicle.

EXTERNAL INPUTS

This group lists external inputs that can be connected to your computer either 
through your HP Tuners interface device or though your computer's serial port. 

The parameters listed here represent the raw, untransformed data from the external 
input. If you applied a transform to this input in the channel l ist, select the transform 
you used from the Transforms group to use the transformed data instead. 

TRANSFORMS

Lists transforms that can be applied to external channels. If you added a channel that 
required a transform, select the transform that was applied to the channel to use the 
transformed output.

NOTE: If there is a generic sensor of the same type, VCM Scanner will prompt you 
to see if you want to use the generic sensor instead. 

MATHS

This group contains parameters that are defined by performing calculations on the 
output of one or more other parameters. There are a number of pre-defined math 
parameters based on commonly-used calculations. But, it 's also possible to create 
custom math parameters of your own. See Math Parameters (Page 157) for more 
information.

Page 153



VCM SCANNER USER GUIDE

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

PARAMETER SEARCH AND FILTERING

Item Description

1.

Data Type Filters. Click an icon to turn off the display of 
parameters with a particular data type. Click again to turn it on. 
Currently-displayed data types have a blue box around them.

Show/hide parameters that provide scalar (numerical) 
data.

Show/hide parameters that provide switch data (the 
current selection in a list of possible options)

Show/hide channels whose output is a flag (a simple 
True/False or On/Off indication).

2.

Filter Parameters Without Channels Click this icon to turn off 
the display of parameters that do not have channels set up to 
provide data for them. Click again to turn the display of these 
parameters on again.
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Item Description

3.

Sort Order. Click an icon to select the order in which 
parameters will be displayed. 

Sort by section

Sort by parameter name

Sort by parameter ID

4.

Tree Expansion. Collapse or expand the parameter tree.

Collapse all items in the list.

Expand all items in the list.

5.

Filter By Parameter Name. To filter the tree display by 
parameter name, enter the text you wish to search for in the 
[Text Filter] box. The displayed tree items will be dynamically 
fi ltered as you type.
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OVERVIEW
Math Parameters Manager can be used to create complex values that take into 
account multiple channels. Once defined, these parameters can be used in gauges, 
graphs, and charts as if they were output from a sensor or PID.

To open this window, select Tools > Math Parameters .

The most commonly used math parameters are built in (predefined). The software 

also allows you to add up to 10 user defined parameters.
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DEFINING MATH PARAMETERS
1. In the Maths - User folder , select the user math parameter that you wish to 

configure.

2. On the right side of the window, enter a Name and an Abbreviation for the 
parameter.

NOTE: The Abbreviation will be displayed on gauges, charts, and other 
locations where space is limited.

3. Enter the Expression for this parameter. This is the formula that will be used to 
calculate the new parameter. See Defining Expressions below.

4. Select the Unit for this parameter.

5. In the Decimals box, enter the number of decimal places to show for this 
parameter's value.

DEFINING EXPRESSIONS
An expression is the mathematical formula that is used to calculate the parameter's 
value. The expression can include the output of sensors and PIDs, which are inserted 
into the expression as variables.

The process for defining an expression is as follows:

1. Insert variables that represent that output of the sensors and/or PIDs that will be 
included in the calculation.

2. Add supported math operations  to complete the desired calculation.

Note that there are two types of expression:

￭ Calculated

￭ Conditional

Page 159



VCM SCANNER USER GUIDE

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

CALCULATED EXPRESSIONS

A calculated expression applies mathematical operations to the output of the sensors 
or PIDs identified in the expression in order to provide a modified signal or a signal 
that is derived from multiple inputs.

Examples:

￭ 100 * ([50119.238] - [50118.238]) / [50118.238]

￭ ([2126.240] * ([6210.71] / 1000) * [50112.254] * [50121]) / [50030.91]

CONDITIONAL EXPRESSIONS

A conditional expression specifies a function that tests the output data stream of the 
sensors or PIDs identified in the expression and produces a TRUE or FALSE result for 
each frame of the output. 

This type of expression is typically used in filters. 

Conditional expressions must return either 1 (TRUE) or 0 (FALSE).

Examples:

￭ [50010] > 25

￭ ([50010] > 25 OR [25] = 50) AND [3131] > 10
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EXPRESSION VARIABLES
When entering expressions for math parameters or filters, variables are used to 
represent the output of a particular sensor or PID. There are two ways to add a 
variable to an expression:

￭ Type the variable specification directly into the Expression box as text.

￭ (Easier) Click the New Variable button to open the Variable Wizard.

ENTERING VARIABLES AS TEXT

The basic syntax for a variable is simply the master Parameter ID for the sensor or PID 
surrounded by square brackets.

For example, a variable that inserts the output of the throttle position sensor would 
be written as follows:

[50090]

SPECIFYING UNITS

There are two ways to specify the units for a variable:

￭ Give the numerical Unit ID. This is the preferred method. 

￭ Enter the symbol  for the unit. This is not as reliable.

Both of these examples specify mph as the unit:

￭ [12345 .114]

￭ [12345 .mph]

Supported symbols and IDs are listed in the Quantities & Units window. 
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VARIABLE MODIFIERS (CASE INSENSITIVE)

avg(x) Calculates the average value of the variable over the period 
that:

￭ begins x mill iseconds before the current time index

￭ ends at the current time index

slope(x) This will calculate the slope between two points:

￭ the value of the variable at x mill iseconds before the 
current time index

￭ the value of the variable at the current time index

shift(x) The value of the variable x mill iseconds before the current 
time index.

NOTE: Using a negative value for x tells VCM Scanner to look at the period AFTER 
the current time index. This works only during playback of recorded data streams. 
When Iive scanning, VCM Scanner can't obtain the specified information (it can't 
look into the future).

VARIABLE EXAMPLES (CASE INSENSITIVE)

￭ [12345]

￭ [12345 .slope(x)]

￭ [12345 .avg(x)]

￭ [12345 .avg(x).10]

￭ [12345 .avg(x).mph]

￭ [12345 .10.avg(x)]

￭ [12345 .mph.avg(x)]
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VARIABLE WIZARD

The variable wizard provides a graphical interface for creating variables. It can be 

opened by clicking the New Variable button or the Edit Variable button in either of 
the following windows:

￭ Math Parameters Manager

￭ Graph Display Layout Editor

Follow these steps to use this wizard:

1. Click the Parameter l ink. The Parameter Selector window appears. See Selecting a 
Parameter (Page 151) for more information on this window.

2. Double-click on the PID or sensor that you wish to use for the variable. 

3. In the Unit dropdown of the Variable Wizard window, select the unit you want to 
use for this variable.

4. If you want to use a special function (modifier) for the variable, select the desired 
function and then enter the associated Period in mill iseconds.

5. Click OK .
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SPECIAL FUNCTIONS

Average Calculates the average value of the variable over the 
period that:

￭ begins Period mill iseconds before the current time 
index

￭ ends at the current time index

Slope This will calculate the slope (rate of change) between 
two points:

￭ the value of the variable at Period mill iseconds 
before the current time index

￭ the value of the variable at the current time index

Shift The value of the variable Period milliseconds before the 
current time index.

NOTE: Using a negative value for Period tells VCM Scanner to look at the period 
AFTER the current time index. This works only during playback of recorded data 
streams. When Iive scanning, VCM Scanner can't obtain the specified information 
(it can't look into the future).
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QUANTITIES & UNITS
This window can be used to look up numerical IDs and symbols for use in math 
parameters and filters. 

To open this window, select Tools > Quantities & Units in the menu bar.

Follow these steps to look up a particular symbol or ID:

1. In the left column, select the quantity being measured.

2. In the right column, select the unit you wish to use.
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3. Either make note of the ID or symbol you wish to use or click one of the buttons at 
the bottom of the window to copy it to the clipboard.
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SUPPORTED MATH OPERATIONS AND FUNCTIONS
The following operations and functions can be used when defining the expressions 
used in math parameters and filters:

MATH FOR CALCULATIONS

The binary operations and functions listed below perform simple math calculations on 
the variables included in the expression.

SUPPORTED BINARY OPERATIONS

+ Sum up two operands.

- Subtract two operands.

* Multiple two operands.

/ Divide two operands.

^ Raise to a power.

SUPPORTED FUNCTIONS

sin(x) Returns the sine of x where x is in radians.

cos(x) Returns the cosine of x where x is in radians.

tan(x) Returns the tangent of x where x is in radians.

abs(x) Returns the absolute value of x.
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round(x) Returns the whole number nearest x.

CONDITIONALS

The relational and logical operations listed below are used when the output of the 
expression is intended to be binary (TRUE or FALSE) such as the expressions used for 
filters.

￭ 1- indicates a TRUE result

￭ 0 - indicates a FALSE result

SUPPORTED RELATIONAL OPERATIONS

> If x > y, result is 1 . If not, result is  0 .

< If x < y, result is 1 . If not, result is  0 .

= If x = y, result is 1 . If not, result is  0 .

SUPPORTED LOGICAL OPERATIONS

AND If x = 1 (TRUE) and y = 1 (TRUE), result is 1 . If not, result is  0 .

OR If x = 1 (TRUE) or y = 1 (TRUE), result is 1 . If not, result is  0 .

& If x = 1 (TRUE) and y = 1 (TRUE), result is 1 . If not, result is  0 .

| If x = 1 (TRUE) and y = 1 (TRUE), result is 1 . If not, result is  0 .
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VIEWING MATH PARAMETER VARIABLE BREAKDOWN
When either a Predefined or a User Defined math parameter is selected, the box in 
the bottom right of the Math Parameters Manager window will display simple descrip-
tions of the variables used in the selected math parameter.

Variables that are highlighted in pink are not currently supported by the active 
channel configuration.
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SHARING USER DEFINED MATH PARAMETERS
If your user defined math parameter is generic enough that you think others might 
use it, please e-mail it to us and we can add it to our Predefined list.

User math parameters are stored in the local computers "VCM Scanner.cfg" fi le. They 
are not distributed with any Channel or Layout configuration. If you build a layout that 
includes user defined math parameters, anyone you share it with will not be able to 
display those controls unless you also share the math parameter and the recipient 
loads the math parameter into the same slot as you.
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RTT™ is an operating system modification available for certain vehicles with LS1 
engines. This mod allows users to change the values of certain parameters in real time 
while connected to the vehicle in VCM Scanner.

NOTE: To do this, the customized operating system copies parameters that are 
normally stored on the controller's internal flash drive into the controllers RAM 
memory. The parameters in RAM can then be modified in real time, without 
flashing the vehicle.

After tuning is complete, the final parameters can be written to the PCM and stored 
permanently using VCM Editor.

FEATURES
￭ Software only, no special hardware required

￭ Enough functionality to tune the car. (Not every parameter requires real time 
support.

￭ Easy to use

￭ Low cost

CAUTION: Do NOT attempt changing real time tune values while driving the 
vehicle. Doing so may cause driver distraction and possible vehicle crash. 
Real time tuning is designed for quick tuning under controlled conditions like 
an engine or chassis dynamometer.

CAUTION: Use caution when entering values into the real time tuning tables. 
Improper use may cause vehicle damage and or unsafe driving conditions. 
The user assumes all safety responsibility for use of and values entered into 
real time tuning mode.
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PROCEDURE
1. In VCM Editor, open a calibration file read from a vehicle that supports the RTT 

operating system modifications. See Operating System Enhancements with RTT 
(Page 174) for a list of these mods and the vehicles they can be applied to.

2. Apply an HP Tuners OS modification that includes RTT capabilities. See Applying a 
Custom OS with RTT (Page 177) for instructions.

3. Select the RTT Mode and write the new calibration to the vehicle. See Selecting the 
RTT™ Mode (Page 181).

4. Open VCM Scanner.

5. Click  to establish a data connection. The RTT icon will appear in the toolbar.

6. Click the RTT icon to open the Real Time Tuning window. See The Real Time 
Tuning Window (Page 182) for more information on using this window.

NOTE: This icon will not be displayed unless you have flashed a tune to the 
vehicle with RTT Mode set to anything other than Disabled.

7. For each table you wish to modify:

a. Use the number buttons at the top of the window to select the table you want 
to modify. Intially, the table will appear blank because its data has not yet been 
copied from the flash drive.

b. Click  to copy the selected table to the controller's RAM memory and tell 

the controller to use the copy in memory rather than the original on its 
internal flash drive.

c. Edit the table as desired. Your changes will take effect in real time.
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d. When you have built a table that you feel is worthy of applying to the vehicle 

permanently, right click on the table and select Copy .

e. In VCM Scanner's toolbar, click  to disconnect.

f. Open VCM Editor and navigate to the tab containing the table that you are 
finalizing.

g. Right-click on the colored background of the table's name and select Paste .

8. When you are ready to write a batch of changes to the vehicle's flash drive, 
perform a calibration only write to the vehicle.

NOTE: You do not have to disable the RTT™ mode in VCM Editor to write changes. 
You can leave the mode set to a desired RTT mode and continue real time tuning 
your vehicle as needed.

OPERATING SYSTEM ENHANCEMENTS WITH RTT
VCM Suite can apply operating system enhancements that add RTT to many vehicles 

that have an LS1 engine from GM. If your vehicle supports these enhancements, you 
will see them listed on the OS tab in VCM Editor.

Details for these custom operating systems are included below. See Applying a 
Custom OS with RTT (Page 177) for instructions on applying any of these custom 
operating systems to your vehicle.
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1BAR MAF ENHANCED (GM GENIII V8)

Available on most vehicles with 1999+ LS1 engines, this enhancement adds RTT to the 
stock calibration.

1BAR SPEED DENSITY ENHANCED (GENIII V8)

Available on most vehicles with 1999+ LS1 engines, this enhancement contains the 
following features:

￭ Adds a VE Multiplier vs. TPS vs. RPM table

￭ Secondary VE table not used (if applicable)

￭ Speed Density Mode Only

￭ Dual (High and Low Octane) Spark table support

￭ Adds RTT (most calibrations)
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2BAR MAP - SPEED DENSITY (GENIII V8)

Available on most vehicles with 1997-2007 LS1 engines, this enhancement contains 
the following features:

￭ 2 bar MAP sensor support (calibration capability for GM 0-5V linear MAP sensors)

￭ Extended Main VE table to 210 kPa (2 bar)

￭ Retains full 5 kPa resolution in non-boost regions (most calibrations)

￭ 5 kPa resolution in boost regions (most calibrations)

￭ Secondary VE table not used (if applicable)

￭ New MAP referenced "Boost Enrich" table

￭ New open-loop MAP threshold

￭ Dual (High and Low Octane) Spark table support

￭ Speed Density mode only

￭ VCM Scanner histogram automatically recognizes and adjusts for 2 bar feature (if 
applicable)

￭ New 2 bar MAP PID for VCM Scanner (if applicable)

￭ Adds RTT (most calibrations)

NOTE: You must use a correctly calibrated 2bar MAP sensor for this application. 
The default MAP sensor calibration values may not be accurate for your MAP 
sensor.

3BAR MAP - SPEED DENSITY (GENIII V8)

Available on most vehicles with 1999+ LS1 engines, this enhancement contains the 
following features:

￭ 3 bar MAP sensor support (calibration capability for GM 0-5V linear MAP sensors)

￭ Extended Main VE table to 315 kPa (2 bar)

￭ Retains full 5 kPa resolution in non-boost regions (most calibrations)

￭ 5 kPa resolution in boost regions (most calibrations)
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￭ Secondary VE table not used (if applicable)

￭ New MAP referenced "Boost Enrich" table

￭ New open loop MAP threshold

￭ Dual (High and Low Octane) Spark table support

￭ Speed density mode only

￭ VCM Scanner histogram automatically recognizes and adjusts for 2 bar feature (if 
applicable)

￭ New 3 bar MAP PID for VCM Scanner (if applicable)

￭ Adds RTT (most calibrations)

NOTE: You must use a correctly calibrated 3bar MAP sensor for this application. 
The default MAP sensor calibration values may not be accurate for your MAP 
sensor.

APPLYING A CUSTOM OS WITH RTT
Applying custom OS that includes RTT is similar to applying any other OS mod.

If you already have an existing VCM Enhancement applied to your vehicle and wish to 
use RTT, you will need to re-apply the VCM Enhancement with RTT from your stock GM 
OS.

CAUTION: Use these enhancements at your own risk. Modifications can result 
in permanent damage to vehicle components. Any modifications that change 
the vehicle's emissions from stock (most modifications do this) are not 
allowed by the EPA and are to be used for off-road applications only. 
Modifying or removing any emissions testing is illegal and subject to heavy 
fines. HP Tuners LLC is not liable for any type of damage caused by use of 
these enhancements. Use at your own risk!
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To apply the enhancement to your PCM:

1. In VCM Editor,  open the stock or existing tune read from the vehicle.

2. Select the OS tab. Enhancements that are available for the PCM's operating system 
will be listed under Code Modifications.

3. Apply the relevant modification by clicking the button.

4. Immediately save the file under a new name. DO NOT make any additional 
changes before saving the file. This is now your new "Base" fi le that must be used 
for all future tuning.

5. Close VCM Editor and then reopen it with the newly saved file. You should see that 
the operating system ID for the vehicle's PCM has changed from your original fi le.
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6. For 2bar and 3bar enhancements only: The VE table will be full of invalid data. 
You *must* create a valid VE table before writing the file to the PCM. 

NOTE: One strategy is to copy your previous VE table into the non-boost 
region and then copy and increase the last row of the VE table to the new 
boost area. It is important to start tuning on the rich side (higher numbers) 
and then work back to your desired AFR.

7. Save the file in the editor, you are now ready to write to the PCM.

IMPORTANT: The next step involves using the "Write Entire" option. Remember 
this option is not 100% recoverable on failure in some circumstances. Do NOT 
disconnect the battery if you have problems during this next step. Once this 
step is completed, you can use the normal "calibration only" write function for 
all tuning changes.

8. Connect to the vehicle and turn on ignition, wait 10 secs.

9. Stil l in VCM Editor with your file open, select Flash > Write Entire . The process 
takes approximately 2-4 minutes depending on vehicle type.

10. When the write is completed, turn off ignition and wait 30 secs.

11. Turn on ignition, wait 10 secs.

12. The PCM should display the new operating system ID. 

13. At this point the PCM should now be running the new operating system and you 
can now use (much safer) calibration only writes for all future tuning changes.
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14. For 2bar and 3bar enhancements only, remove the 1bar SAE Manifold Air Pressure 
PID and replace it with the appropriate 2 or 3 bar PID: 

a. Open VCM Scanner and connect to the vehicle. 

b. In the Channels list, right-click the Manifold Air Pressure (SAE) PID select 
Remove Channel . 

c. Right-click in the Channels list and select Add Channel .

d. Go to the Engine > Airflow folder.

e. Choose either the Manifold Air Pressure - 2 bar or Manifold Air Pressure - 3 
bar PID. Double-click to insert it into the table.

NOTE: If you don't do this, layouts that use MAP parameters will not function 
correctly.

15. For 1/2/3 bar Speed Density enhancements only:

￭ Right-click the Mass Air Flow(SAE) PID and select Remove Channel . 

NOTE: This removes the existing MAF PID. If you don't do this, layouts that use 
MAF parameters will not function correctly.

16. If you made any changes to the channel configuration in step 14 and/or step 15 , 

click  to save your changes.

You are now ready to select the RTT mode.
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SELECTING THE RTT™ MODE
Due to the limited amount of space in the vehicle control module's memory, it can 
only maintain a few tables in RAM at one time. 

VCM Suite gets around this obstacle by giving you modes of operation to choose from. 
Each mode loads a set of tables that allows you to accomplish one major task, l ike idle 
or VE tuning. 

To select the RTT mode you wish to use:

1. In VCM Editor, open the tune file to which you applied the RTT OS Mod.

2. In either the tab navigation interface or Parameter Navigator, select Engine > 
General .

3. Use the Real Time Mode dropdown to select the mode you want.

NOTE: The modes are named for the tuning task they are meant to be used 
for.

4. Write the calibration to the vehicle (write calibration only).

NOTE: If you do not select a mode other than Disabled, the RTT icon will not be 
displayed in VCM Scanner's toolbar.
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THE REAL TIME TUNING WINDOW
If you have selected an RTT Mode other than Disabled in VCM Editor and then written 
the tune to the vehicle, the RTT icon will appear in VCM Scanner's toolbar when you 
connect to the vehicle.

Click this icon to bring up the Real Time Tuning window. 

This window is similar to the Table Editor in VCM Editor and includes many of the 
toolbar icons and the right click menu from that window. See the Table Editor section 
in the VCM Editor User Guide for more information on these functions.
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ADDITIONAL TOOLBAR ICONS

This window includes a few additional toolbar icons that are not present in the VCM 
Editor.

Select Table: Each of these numbers represent a table that is available for 
real time tuning in the current mode. Click a number to select the cor-
responding table.

By default, the controller will use the versions of these tables that are stored 
on its flash drive.

Use RAM Version: Intstruct the controller to use the version of the selected 
table in RAM. This allows the table to be modified in real time.

Use Flash Version: Instruct the controller to user the version of the table on 
the flash drive. This table cannot be modified in real time.

Use Flash Version for All: Instruct the controller to switch to the flash 
versions of all tables.

COPYING A TABLE TO RAM AND MAKING IT ACTIVE

When you are ready to start tuning a table in real time:

1. Select the table by clicking the number corresponding to the table you want to 
modify. Initially, the table will appear blank because its data has not yet been 
retrieved from the flash drive.

2. Click . This will tell the vehicle controller to copy the table into RAM memory 
and start using that copy rather than the original table on its internal flash drive.
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USING THE FLASH TABLE AGAIN

If you have built a table in RAM that you do not wish the vehicle to use  anymore, 

simply click . This will tell the vehicle to use the table that is located on the flash 

drive and not the one RAM.

NOTE: This will not remove your changes to the table in RAM. If you click the Use 
RAM Version icon again, you can continue tuning the table where you left off. Your 
changes will not have been lost.

If you want to erase the tables in RAM, simply key off or cycle the ignition. Any changes 
made to the table in RAM will be lost and refreshed with table data from the flash 
drive.
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The Controls and Special Functions window allows you to instruct the vehicle to 
perform certain tasks in real time.

To open this window, do one of the following (while connected to the vehicle):

￭ In the toolbar, click .

￭ in the menu bar, select Vehicle > Controls & Special Functions .

Functions available in this window will vary based on vehicle manufacturer, the 
controllers the vehicle contains, and the operating system version of those 
controllers.

Some of the functions that require special instructions are described below.
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CAUTION: Although it is possible to instruct the vehicle controllers to 
perform any of the functions listed in this window, it's not always wise to do 
so. Executing certain functions at the wrong time can have unintended con-
sequences - up to and including damaging the vehicle. Be aware of the effects 
of the function you are attempting to execute before you proceed.

CRANK RELEARN
Before starting, make sure your laptop or PC has access to the Internet. 

1. Plug your HP Tuners interface device into the vehicle's OBD-II port and connect 
the USB cable to your computer. 

2. Open VCM Scanner.

3. Run the engine until the vehicle reaches normal operating temperature (ECT > 
~65C or 150F).

4. Put the vehicle into Park (auto) or Neutral (manual).

5. Turn off all accessories including the A/C, heater, and fans.

6. Turn the vehicle off.

7. Apply the parking brake.

8. Press the brake pedal. Keep the brake pedal depressed during the entire 
procedure .

9. Start the vehicle and let it idle.

10. In VCM Scanner, click Begin .

11. Gradually rev the vehicle to fuel cutoff (around 4000-5000 RPMs) over a period of 
about 4 seconds. When fuel cuts out, immediately release the throttle.

12. Allow the engine to come back to an idle.

13. Turn the ignition off for at least 15 seconds. This step is required for the VCM to 
store the newly learned configuration.
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TRANS CLEAN
1. Ensure that the PID "Cleaning Status" is in your Channels list. The displayed value of 

this PID will keep you informed of the current status of the Trans Clean process. 

2. Meet the following conditions before enabling Trans Clean: 

￭ Engine running at idle

￭ Vehicle not moving

￭ Transmission selector in Park

￭ Transmission temperature 70 - 110 Degrees Celsius.

3. In the Vehicle Controls & Special Functions window, initiate the transmission 
cleaning procedure.

NOTE: During this test the engine speed will increase and decrease automatically 
and various clutch noises may be heard from the transmission.

TRANS FAST LEARN
1. Ensure that the PID "Fast Learn Status" is in your Channels list. The displayed value 

of this PID will keep you informed of  various required operator actions and steps 
in the Fast Learn process.

NOTE: You have 2 seconds to comply with any instructions such as Selecting D 
or R, otherwise, the test will be aborted. 

2. Meet the following conditions before enabling Trans Fast Learn: 

￭ The engine running at idle

￭ Transmission temperature 70 - 95 degrees Celsius

￭ Vehicle not moving

￭ Brake pedal must be applied during the entire test
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3. In the Vehicle Controls & Special Functions window, initiate the transmission fast 
learn procedure.

NOTE: During this test, the engine speed will increase and decrease automatically 
and various clutch noises may be heard from the transmission.
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SCANNING ARCHITECTURE
The image below is intended to show the data flow throughout the interface 
connections and application.

FILE ARCHITECTURE
Use this to better understand the complexity of VCM Scanners open/save dialogs.

Most files are saved in .xml format to enable outside modification if desired, for 
advanced users.

ARCHITECTURE BY FUNCTION

VCM SCANNER

￭ Stores the active Channel Configuration

￭ Stores the active Channel Display Properties

￭ Stores the active Layout Configuration

￭ Stores the active Layout Display Properties
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￭ Stores user Math Parameters

￭ Stores user Transforms

￭ Stores user Preferences

CHANNELS

￭ Reloaded from VCM Scanner.cfg on open

￭ Saved to VCM Scanner.cfg on close

￭ Can be saved/loaded from user saved files

LAYOUT

￭ Reloaded from VCM Scanner.cfg on open

￭ Saved to VCM Scanner.cfg on close

￭ Can be saved/loaded from user saved files
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ARCHITECTURE BY FILE TYPE

VCM SUITE.CFG

￭ Location: \My Documents\HP Tuners\Settings\

￭ Created by the VCM Scanner/Editor applications only

￭ Shared between VCM Scanner/Editor instances

￭ Application Keys

￭ Unit System

￭ Tuning Path

VCM SCANNER.CFG

￭ Location: \My Documents\HP Tuners\Settings\

￭ Created by the VCM Scanner application only

￭ Shared between VCM Scanner instances

￭ Stores Active Channel Configuration

￭ Stores Active Channel Display Properties

￭ Stores Active Layout Configuration

￭ Stores Active Layout Display Properties

￭ Stores User Math Parameters

￭ Stores User Transforms

￭ Stores Application Preferences & Settings

*.CHANNELS.XML

￭ Default Location: \My Documents\HP Tuners\VCM Scanner\Channel Configs\

￭ Created by users only

￭ Stores Parameter ID and Source

￭ Stores Channel Polling Intervals

￭ Stores Channel Transforms
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*.CHANNELDISPLAY.XML

￭ Default Location: \My Documents\HP Tuners\VCM Scanner\Channel Configs\

￭ Created by users only

￭ Stores Channel Display Fonts and Colors

*.LAYOUTS.XML

￭ Default Location: \My Documents\HP Tuners\VCM Scanner\Layouts\

￭ Created by users only

ARCHITECTURE BY FILE TYPE - GAUGES

*.GAUGES.XML

￭ Default Location: \My Documents\HP Tuners\VCM Scanner\Gauges\

￭ Created by users only

￭ Stores all gauges on the selected display

*.GAUGE.XML

￭ Default Location: \My Documents\HP Tuners\VCM Scanner\Gauges\

￭ Created by users only

￭ Stores a single Gauge

*.GAUGEDISPLAY.XML

￭ Default Location: \My Documents\HP Tuners\VCM Scanner\Gauges\

￭ Created by users only

￭ Stores Gauge Display Fonts and Colors
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ARCHITECTURE BY FILE TYPE - GRAPHS

*.GRAPHS.XML

￭ Default Location: \My Documents\HP Tuners\VCM Scanner\Graphs\

￭ Created by users only

￭ Stores all graphs on the selected display

*.TABLE.XML

￭ Default Location: \My Documents\HP Tuners\VCM Scanner\Graphs\

￭ Created by users only

￭ Stores a single Table

*.GRAPHDISPLAY.XML

￭ Default Location: \My Documents\HP Tuners\VCM Scanner\Graphs\

￭ Created by users only

￭ Stores Graph Display Fonts and Colors

ARCHITECTURE BY FILE TYPE - CHARTS

*.CHARTS.XML

￭ Default Location: \My Documents\HP Tuners\VCM Scanner\Charts\

￭ Created by users only

￭ Stores all charts on the selected display

*.CHART.XML

￭ Default Location: \My Documents\HP Tuners\VCM Scanner\Charts\

￭ Created by users only

*.SERIES.XML

￭ Stores a single Chart and its associated Series
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￭ Default Location: \My Documents\HP Tuners\VCM Scanner\Charts\

￭ Created by users only

￭ Stores a single series

*.CHARTDISPLAY.XML

￭ Default Location: \My Documents\HP Tuners\VCM Scanner\Charts\

￭ Created by users only

￭ Stores Chart Display Fonts and Colors
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OVERVIEW
HP Tuners does not currently offer incoming phone support. The best way to reach 

our Support Department is to create a ticket . If you prefer to speak with someone on 
the phone, just let us know in the ticket and we'll call you back as soon as possible.

When you contact us, we may ask for an infolog, a debug.dat fi le, or a license file. 
Having these files ready may speed up the support process.

HOW TO GENERATE A VCM SUITE INFOLOG
When contacting customer support, it 's often helpful for us to have a copy of a VCM 
Suite Infolog. The Infolog must be generated while connected to your vehicle.

GENERATING AN INFOLOG
1. Click the VCM Suite Info button in either VCM Editor or VCM Scanner.

NOTE: make sure your cable is connected to the vehicle and the vehicle's key 
is in the ON position before proceeding. 

2. Click the blue circle "i " icon to poll the software and the vehicle. 
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NOTE: This step may take five to twenty seconds to complete.

3. When Infolog generation is finished, click on the Save icon. Once the file is saved, it 
is ready to email to our Support team.
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LOCATING THE DEBUG.DAT AND LICENSE.DAT FILES
For many support issues, we ask that you provide us with a debug.dat fi le. This fi le can 

be found in This PC > Documents > HP Tuners > Settings :

We may also ask for a license.dat fi le. This can found in the same file path.
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